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Working with Client Accounts

In Morningstar Direct™ for Wealth Management, client accounts allow you to enter Overview

and analyze actual client holdings. Further, you can assign custom benchmarks and
an investment policy to the accounts to aid in that analysis. This guide provides
instructions on how to create and use these related items, as well as how to
connect them to accounts.

In this manual, the following topics are covered:

» Creating a Client Account (page 17)

» Working with Custom Benchmarks (page 17)

» Using an Investment Policy (page 42)

» Assessing the Impact of Fees on Client Accounts (page 63), and
» Editing a Client Account (page 70).

Holdings Correlation » USD = 04/01/2018 - 03/31/2078 = Karen Franklin X
1 i 3 4 5
W 07610 1.00
1 American Funds Fundamental Invs A W05t 0TS A variety of charts and tables
can be used to analyze a
2 American Funds Growth Fund of Amer A m 0.26t00.50 client account.
— 0.01t00.25
3 American Funds Ltd-Term Tx-Ex Bd A 0.2 yoldings Analysis » Holdings Summary = USD = 03/31/2012 = Karen Franklin
4 American Funds New Economy A Momingstar
Analyst Return (1M Return {3M  Return {GM
5 American Funds ST Bd Fd of Amer A -0. Name Rating - mo-end) -mo-end) - mo-end}
Karen Frankiin e 1.53 11.03 -1.61
Sample Custom Benchmark o 143 961 —0.70
1 American Funds Growth Fund of Amer A Bronze 01 3T 144
2 American Funds Fundamental Invs A Gold 1.25 196 —201
3 American Funds New Economy A Gold 192 1458 —0.46
4 American Funds 5T Bd Fd of Amer A Bronze 0.47 102 209
5 American Funds Ltd-Term Tx-Ex Bd A Bronze 0.75 179 2401
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Creating a Client Account

Overview

Creating a Client Account

Client accounts allow you to easily track and analyze a client’s investments. You can
also compare the account to a custom benchmark or investment policy.

In this section, you will learn how to do the following:

» Exercise 1: Create a client account from scratch (page 6)
» Exercise 2: Create a client account by importing (page 11)

You might need to manually create a client account in the following circumstances:

» You want to mock up an account based on a model portfolio (to represent a client’s
held-away assets).

» You want to create an account for a prospect who is not yet a client, or

» You are a potential user on a trial license and your client holdings are not
automatically recreated in Morningstar Direct for Asset Management.

In this exercise, you will create a client account to represent the holdings of a prospect,
Karen Franklin. She needs assistance in diversifying in her traditional IRA. Karen is 63
and plans to retire next year. She has given you a printout of the current holdings in the
IRA. You will input the investments, set weights for them, and so on. This client
account will be used in exercises throughout this guide.

To create a client account, do the following:

1. On the header, click the Create icon and select Client Account. The Creating Accounts
window opens.

# Note: If the Create menu doesn’t show an option for Client Account, contact your CSM.

Create

Overview

Exercise 1: Create a client
account from scratch

Note the
highlighted
selections.

MORNINGSTAR Direct =

Search for Securities and Research
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Creating a Client Account Exercise 1: Create a client account from scratch

2. (Optional) In the upper-right carner of the Untitled area, click the Expand icon. The
Untitled area expands to the full size of the window, making it easier to read.

CREATING ACCOUNTS Save As Rename Close|
Untitled 11/26/2018 | Allocation: Asset Allocation 10/31/2018 2
C’Ih—l = Click here to expand
- 100.00 W Stack (Net} this table.
M Bond {Net}
Name Weight > Market Value{USI Cash (Met}
Y. W Pref (Net)

Edited 100.00 10,000.01 50.00 M Convert (Nef

Morningstar Mod Tgt Risk TR USD — = W Other {Net}

Unallocated Cash 100.00 10,000.01

0.00

Existing  Edited Benchmark
Current default portfolio date is yesterday. Please use "Edit Current Investment Growth: 10K Growth 117272017 -111... 5 1]
Date" option to change the date if you don't want to use yesterday as — Benchmark

portfalio date. 1076658

mA PRTYA'Al

3. To select the investments for the account, in the upper-left corner of the Creating
Accounts window, click the Add icon. The Add menu opens.

CREATING ACCOUNTS Save As | Remame Close

Untitled 10/10/2018 [ 2t
[ Recalculate ]
Iil E— Click here.
Market Asset Alloc
Name Weight > Value(USD) > Shares > Price Ticker Stock (Net)
Edited 100.00 10,000.00 - - - -
Momingstar Mod Tgt Risk TR USD = s = S 5972
Unallocated Cash 100.00 10,000.00 10,000.00 1.00 — 0.00
MOHNINGSTAH Morningstar Direct for Wealth Management August 2019 7
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Creating a Client Account

Exercise 1: Create a client account from scratch

4.

In the Search field, enter AGTHX. The results list displays more than one selection.

Select American Funds Growth Fund of Amer A.

Add

Q[ acTHx |

Type AGTHX here.

wth Fund of Amer A
LW

Frequently Accessed  |dentifier Type Exchange
American Funds Gro  AGTHX Open-End Fund NASDAQ
wth Fund of Amer A

American Funds Gro  AGTHX lw Open-End Fund NASDAQ

Select this option.

American Funds Growth Fund of Amer A is displayed in the Creating Accounts window,

under Unallocated Cash.

CREATING ACCOUNTS

Save As

> Market Value{USD)

0.00

0.00

>

Close
o P

Shares >
Each instrument is initially
— categorized as Unallocated
- Cash, with no weight, market
value, or number of shares.
0.00

Untitled 03/31/2016
Mame Weight
e |
Edited 100.00
Marningstar Mod Tgt Risk TR USD =
Unallocated Cash 100.00
| American Funds Growth Fund of Amer A =

MAORNINGSTAR
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Creating a Client Account Exercise 1: Create a client account from scratch

5. Use these tickers to add the following funds:

» ANCFX (American Funds Fundamental Investments A)
» ANEFX (American Funds New Economy A)

» ASBAX (American Funds ST Bd Fund of Amer A), and
» LTEBX (American Funds Ltd-Term Tx-Ex Bd A).

CREATING ACCOUNTS Save As Hename Close
Untitled 03/31/2016 P
+
Name Weight > Market Value(USD) > Shares >
- ¢
Edited 100.00 0.00 — m—
2 S e = ) e list of investments
Varningstar Mod Tgt Risk TR USD - - - should look like this.
Unallocated Cash 100.00 0.00 0.00
1 American Funds Growth Fund of Amer A - - -
Z Amencan Funds Fundamental Invs & = S =
3 American Funds New Economy A - —_ —_
4 Amencan Funds ST Bd Fd of Amer A — — —
5 American Funds Ltd-Term Tx-Ex Bd A — — —

6. Change the Weight of each fund according to this table:

<= Note: Press Enter after each entry to move to the next one.

Fund Weight

American Funds Growth Fund of Amer A 40

American Funds Fundamental Investments A | 20

American Funds New Economy A 15
American Funds St Bd Fund of Amer A 15
American Funds Ltd-Term Tx-Ex Bd A 10

Morningstar Direct for Wealth Management August 2019 9
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Creating a Client Account Exercise 1: Create a client account from scratch

7. At the top of the Market Value column, enter 1000000.

CREATING ACCOUNTS

Untitled 03/31/2016 EE N

—|— Recalculate

MName Weight >  Market Value(USD) > Shai
W

Edited 100.00 | 1.1](]I].UI]II.I]I}|

Enter the account’s value here.

Marningstar Mod Tgt Risk TR USD - -

Unallocated Cash 0.00 0.00 0.(
1 American Funds Growth Fund of Amer A 40,00 400,000.00 9a4.
2 American Funds Fundamental Invs A 20.00 150,000.00 3931
3 American Funds New Economy A 15.00 200,000.00 £30. .

. - Enter the weight for each

4 American Funds ST Bd Fd of Amer A 15.00 150.000.00 1.501. holding here
5 Amernican Funds Ltd-Term Tx-Ex Bd A 10.00 100,000.00 526.

8. If you expanded the list of holdings in step 2 on page 7, click the Collapse icon so you
can see how the other charts are affected when you recalculate.

9. Click Recalculate.

Click here to
collapse
CHEATING ACCOUNTS this table.
Untitled 10/10/2018 £
_|_ [ Recalculate ] :
After entering
values and
Market Asset Alloc weights for
Mame Weight > Value(USD) > Shares > Price Ticker Stock (Net A
e ol i {Net] elz?cmoldmg,
click here.

10. In the upper-right corner of the window, click Save As.

CREATING ACCOUNTS \ Save As Rename Close Click here t
ick here to save
Untitled 03/31/2016 4% w3 Allocation: Asset Allocation 03/31/2019 4% o3 | theclientaccount.
+ 100.00 m Stock {Ne)
W Bond (Net}
Cash (Net}
Name Weight >  Market Va B Fref (Net}
=y
W Convert {Net)
Edited 100.00 100 B
7 X s M Other (Net}
Marningstar Mod Tgt Risk TR USD = 000
Unallocated Cash 0.00 . )
i Existing Edited Benchmark
1 American Funds Growth Fund of Amer A 40.00 4
2 Amencan Funds Fundamental Invs & 20,00 J Investment Growth: 10K Growth 04/20/2018 - 04. .. {} 5
3 American Funds New Economy A 15.00 1
4 American Funds 5T Bd 7d of Amer A 15.00 1 — Edited  — Banchmark
5 American Funds LtdTerm Tx-Ex Bd A 10.00 1 11,691.54
MmHNlNGS.mH Morningstar Direct for Wealth Management August 2019 10
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Creating a Client Account Exercise 2: Create a client account by importing

11. In the "Save portfolio as” dialog box, enter Karen Franklin, then click Save. In the
upper-left corner of the Creating Accounts window, “Untitled” is replaced with
“Karen Franklin.”

Enter a name.

12. In the upper-right corner of the window, click Clese. The dialog box closes.

Karen Franklin is also interested in improving the performance of her husband’s IRA. In
this case, she has provided a Microsoft® Excel® spreadsheet, listing his investments.
You can import it directly into a client account, instead of manually entering the
investments and weights (as you did in Exercise 1 on page 6).

In this exercise, you will import an Excel file to create a client account for Joe Franklin.
@ Note: When using an Excel file on your own, be sure to first check the requirements for
importing an Excel file, found in Data Import Specifications.
To import an Excel file, do the following:

1. Download the Excel file for this exercise.

2. Inthe upper-left corner of the Home page, hover the cursor over and select Import. The
Import page opens.

Exercise 2: Create a client
account by importing

— Ment | Home

Home >

X LONE MORNINGSTAR Direct

Morningstar Research

ch for Securities and Research... |

Markets

AMNALYZE
[# Create v Client Accounts
Type Last Modified Mame
—
iat 7/20/2019 g Franklin
MANAGE List 07/29/2019 Joe Frank
= You es L

Note the
highlighted selections.

resentation Studio

Asset Allocation

Morningstar Direct for Wealth Management August 2019
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https://advisor.morningstar.com/AWSOE/Training/DataImportSpecifications.pdf#page=11
http://morningstardirect.morningstar.com/clientcomm/JoeFranklin.xls

Creating a Client Account Exercise 2: Create a client account by importing

3. Atthe left side of the Import window, the Upload File option is selected. Click Select File
Type, then select Account Holdings. To the right of the Select File Type button, the
Upload File icon appears.

Import

Import
Upload File d Select File Type
Preview Data

Stlect File Type

. Note the highlighted selections.
njestment List
nfestment List with Custom Data

Model Portfolios

Custam Benchmark

Portfolio Return and Custom Data

4. Click Upload File. A navigation window opens.

Upload File s Account Haldings | | 6] -
: w Click here.

Preview Data

5. On your computer system, locate and double-click JoeFranklin.xls (the file you just
downloaded). The Import page opens, displaying mapping options.

Morningstar Direct for Wealth Management August 2019
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Creating a Client Account

Exercise 2: Create a client account by importing

6. Inthe Column Mapping area, use the pull-down menus to make a selection from each
Unmapped field. Each unmapped column must correspond to a column in the Excel
spreadsheet. A selection for each column is required.

Import

Upload File

Preview Data

Import

Map each column to
the appropriate heading.

@ Exclude Inactive Investments

Account Holdingss JoeFranklinxls X| @
Column Mapping Riese
Date A Account Name v SymbolTicker W Helding Name ]
= Price Currenc
Account Name icker Security Mame
Joe Franklin BPTRX Baron Partn
Joe Franklin BADAX Brown Advisory ]
Marl
L Curranc
Security [dentifier Mapping eight ?
(@ Symbol/Ticker Security Type
Security Mapping Option () Exclude Header Row Date Format
First 1 row W MM/DD/YYYY v

Be sure to select Market
Value, not Market
Value Currency.

7. In the Exclude Header Row field, make sure First 1 row is selected.

8. From the Date Format menu, select MM/DD/YYYY (or the date format you want to use).

9. In the upper-right corner of the window, click Preview Data. The Import Status
window opens.

Import

Import

Upload File

Preview Data

Accour JoeFranklinxls x| &
Column Mapping HESE]
Date v Account Name W Symbol/Ticker W Holding Name v Market Value
Account Name Ticker Security Name IV Value
Joe Franklin BPTRX Baron Partners 2
Joe Franklin BADAX 1
3
Security Identifier Mapping
(@ Symbol/Ticker
Security Mapping Option (%) Exclude Header Row Date Format
First 1 row W MM/DDAYYYY A%

@ Exclude Inactive Investments

You might need to
scroll right to map
additional columns.

Note the selections here.

MAORNINGSTAR
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Creating a Client Account

Exercise 2: Create a client account by importing

10. Under Account Holdings, click Preview Data Section.

Import

Impaort

Model Portfolios w

Upload File >

Preview Data
Import Status

Investment List

m

View your results in Previ

Mara ic rasdy fAr Browiow
Uata 15 reacy Tor preview

Account Holdings

Tl=ta ie pamdy fmr mrauiam
Uata 15 ready ror preview

Madel Portfolios

preview.

View your results in Previ

Mn= e ormm AL e
Uata 15 ready 10

Click here.

< Note: In the Preview Data window, securities listed as “New" have not been imported before.
Existing Securities have been previously imported. Some securities in the spreadsheet being

imported might be listed under Existing Securities.

Import

Upload File

Account Holdings

Securities (19)

i |

Dadge & Stk
Brown Advisory Eq. .
Brown Advisory S
Cullen Internation
Hodges Blue Chip
Hodges Pure Contr. ..
T. Rowg Bree T

Existing Securities

AMG Yacktman |

American Funds A..

LMo = A~ e | =

American Funds A

Symbal/Ticker

All the securities
L (New and Existing)
are error-free.

11. Click Next.

MAORNINGSTAR
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Creating a Client Account Exercise 2: Create a client account by importing

12. If you have imported files before, the holdings for Joe Franklin might not be together on
the list. In that case, do the following:

A. Sort the Account Name column by clicking the column heading.
B. Scroll up or down to find the listings (which will now be together on the list).

13. Click the circle next to each Joe Franklin row, then in the upper-right corner,

click Next.
Import
Upload File Account Holdings v | Back Mext
Preview Data >
Status  Account Mumber Acoount MName As of Date Share
] 1 JOE FRANKLIN Joe Franklin 2015-12-08
5 - e oo Select
] 2 JOE FRANKLIN Joe Franklin 2015-12-08 each Joe
©® 3 JOE FRANKLIN Joe Franklin 2015-12-08 Frankin row.
] 4 JOE FRANKLIN Joe Franklin 2015-12-08
] 5 JOE FRANKLIN Joe Franklin 2015-12-08
L] B JOE FRANKLIN Joe Franklin 2015-12-08
] 7 JOE FRANKLIN Joe Franklin 2015-12-08
] 8 JOE FRANKLIN Joe Franklin 2015-12-08
& g JOE FRANKLIN Joe Franklin 2015-12-08
10 karen Franklin 2015-12-08
11 ¥aren Franklin 2015-12-08

14. The final Preview page shows accounts, not individual securities. Click the circle
at the left of the row for Joe Franklin, then in the upper-right corner of the window,

click Import.
Import
Import
Upload File Account Haoldings v ) [il
Preview Data >
Select the Joe
Franklin account,
then click Import.
Status Account Number ACcol Name Date/Time
New Accounts (Mo E
1 JOE FRANKLIN Joe Franklin 2019-05-17 155
2 MODERAT Moderate 2013-04-22 124...
MmHNlNGSTAH Morningstar Direct for Wealth Management August 2019 15
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Creating a Client Account Exercise 2: Create a client account by importing

15. A message opens, announcing the account was imported successfully. Click
Portfolio Workbook. The “Select a portfolio list to view in this workbook” dialog
box opens.

Good news, your account has (have) imported successfully. To see

your account in action go to thechlrﬁulm Workbook. |I0 import Click here.

another account, select your File Type and click Upload.

16. In the “Select a portfolio list to view in this workbook” dialog box, select
All Client Accounts.

Select a portfolio list to view in this workbook X

All Custom Benchmarks
All Model Portfolios

All Client Accounts

Select this option.

In the workbook, the Joe Franklin account is displayed in the Grid.

Portfolio Analysis | Client Accounts v

i) Column Set
Total Total Total
Return Return Return
_ (YTD - {6M - {1Y - mo-
| Name mo-end) mo-end) end)
14.53 483 1Z15 | The imported client account is
13.08 3.08 3.4 named Joe Franklin.
16.15 6.15 7.04
1388 RE 444
248 343 633
MmHNlNGSTAH Morningstar Direct for Wealth Management August 2019 16
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Working with Custom Benchmarks Overview

Working with Custom Benchmarks

A custom benchmark is created by manually adding indexes or investments and Overview
allocating weights to them, or by importing a file. The blended benchmark can then be
used in the following ways:

» Assigned to client accounts
» Displayed in various charts and tables, and
» Used as a reference point when analyzing client accounts.

This section covers the following topics and exercises:

» Why should | use a custom benchmark? (page 17)

» Exercise 3: Create a custom benchmark (page 18)

» Exercise 4: Create a custom benchmark of Morningstar indexes (page 21)

» Exercise b: Import a set of custom benchmarks (page 24)

» Exercise 6: Apply custom benchmarks to a client account (page 29)

» What are the options for displaying benchmarks? (page 32)

» Exercise 7: Compare the Morningstar Sector allocations of a client account and
a benchmark (page 32)

» Exercise 8: Compare the historical returns of an account and both
of its benchmarks (page 36)

» Exercise 9: Hide a benchmark (page 37)

» Exercise 10: Compare the Sustainability Ratings Analysis of a client account and
both of its benchmarks (page 38)

When comparing a client account to a common yardstick of market performance, such Why should | use a
as the S&P 500 or the Bloomberg Barclays U.S. Aggregate Bond Index, the results custom benchmark?
might not always be helpful, unless the client is fully invested in that asset class—all

stocks or all bonds. Very few investors hold just those positions.

A custom benchmark can help you discover if the investment selections in a client
account are helping or hurting the returns. A benchmark is also a view into whether
the account could benefit from a simpler and less expensive mix of holdings.

Morningstar Direct for Wealth Management August 2019 17
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Working with Custom Benchmarks Exercise 3: Create a custom benchmark

In this exercise, you will create a custom benchmark composed of indexes. When the Exercise 3: Create a
goal is moderate risk and returns, this benchmark can be a measuring and comparison custom benchmark
tool. Is the client’s account too conservative to meet his or her investment goals? Too

risky for his or her comfort level? Which current holdings are contributing to the

conservative or risky nature of the account?

The indexes in the custom benchmark have been selected to reflect the asset allocation
of the client account, rather than what the wealth manager would necessarily
recommend for the client.

Do the following:

1. On the header, click the Create icon, then select Custom Benchmark. The Creating
Custom Benchmarks window opens.

Create
’ L7 List
I’ ly
 NOMMGSMDIect > —
( Q. Search far Securities and Research..
Lists & Screens Client Accounts
Mame Type  Last Modified Name il
Blockehain List 08/23/2018 Scott Tucker H]
Stocks to Watch List 08/Z3/2018 Richard Ha 8
2. Inthe upper-left corner of the Untitled area, click the Add icon. The Search dialog
box opens.
CREATING CUSTOM BENCHMARKS Save As | Rename Close
Untitled 01/31/2016 {3 0 Allocation: Asset Allocation 01/31/2019 {3
| +| 100.00 I W Siock |he Clle here_
W Band {Nat
] Cash (M=t
Name Weight > I Pref (Net|
; B Canvert (P
Edited 100.00 ST
Morningstar Mod Tgt Risk TR USD — 0.00 d |
Unallocated Cash 100.00 Fuisting  Egited  Benchmark
MmHNlNGSTAH Morningstar Direct for Wealth Management August 2019 18
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Working with Custom Benchmarks Exercise 3: Create a custom benchmark

3. Inthe Search field, type S&P 500 TR USD.

4. In the search results, click that index. The Search dialog box closes and the S&P 500 TR
USD index is added to the list in the Untitled area.

CREATING CUSTOM BENCHMARKS

Untitled 09/12/2015 AN
+
Add AssetAlloc Stock  Asset Alloc
N {Net)
1 || Q sEp 500t usd X | B
| Frequently Accessed Identifier ~ Type Exchange 60,18 3 Select this index
t | S&P 500 TR USD Index -
S&P 500 TR USD(1936) Index
S&P5000-3Y HY Corp Bd TR USD Index
S&P5000-3Y1G Corp B TR USD Index
S&P 500 10+ Y HY Corp Bd TR USD Index
S&P 500 10+ Y IG Corp Bd TR USD Index
S&P 500 2x Inverse Daily TR USD Index
S&P 500 3+ Y Bd TR USD Index

5. Repeat step 2 through step 4 to add each of the following indexes:

Russell 2000 Growth TR USD

Russell 2000 Value TR USD

BBgBarc US Agg Bond TR USD

MSCI ACWI Ex US (EAFE Prior to 07/01/13), and
BBgBarc US Treasury Bill 1-3 Mon TR USD.

@ Note: Allow time for each index to load before adding the next.

v vV VvV VvV VY

6. In the Weight column, change the weight of each index as shown in the following table:

@ Note: Press Enter after each entry to move to the next row.

Index Name Weight
S&P 500 TR USD 40
BBgBarc US Agg Bond TR USD 25
MSCI ACWI Ex US (EAFE Prior to 07/01/13) 20
Russell 2000 Growth TR USD 5
Russell 2000 Value TR USD 5
BBgBarc US Treasury Bill 1-3 Mon TR USD 5

Morningstar Direct for Wealth Management August 2019 19
MOHMNHSTAH © 2019 Morningstar. All Rights Reserved.



Working with Custom Benchmarks

Exercise 3: Create a custom benchmark

7. Inthe upper-right corner of the Untitled area, click Recalculate.

_|_

Name Weight > Price Ticker
e T

Edited 100.00 - —
Marningstar Mod Tgt Risk TR USD - — MSAA. .
Unallocated Cash 0.00 1.00 —

1 8&P 500 TR USD 40,00 784582 —

Z BBgBarc US Agg Bond TR USD 25.00 182428 —

3 MSCI ACWI Ex US (EAFE Prior to 07/01/13) 20,00 100 —

4 BBgBarc US Treasury Bill 1-3 Mon TR USD 5.00 19220 —

5 Aussell 2000 Growth TR USD 500 5,006.23 —

B Aussell 2000 Value TR USD 5.00 811282 —

" Recalculate ]

Click here to update
the allocation totals.

8. Inthe upper-right corner of the window, click Save As. The Save As dialog box opens.

CREATING CUSTOM BENCHMARKS
Untitled 09/12/2015

+

Name

Edited

Marningstar Mod Tgt Risk TR USD
Unallocated Cash

TR USD

Growth TR USD

Value TR USD

2 88g gregate Bond Treasury TR
9 M Priar ta 07/01/13)
& BBgBarc US Treasury Bill 1-3 Mon TR USD

LN
1000

Allocation: Asset Allocation 08/31/2018

Asset Alloc Stock Asset Alloc
Weight > Price Ticker (Net)
75.00
100.00 . 50.00
- . 60.18
0.00 -
4000 100.00 5000
5.00 100.00
5.00 100.00
2500 - m
2000 —
5.00 192.20 -

9. Inthe Save As dialog box, enter Sample Custom Benchmark, then click Save.

Save portfolio as

Sample Custom Benchmark]

Enter a name here.

T
( Ca |
(_Cancel )

10. In the upper-right corner of the Creating Custom Benchmarks window, click Close.

M Stack [Net)
W Bond (Net)
Cash (Net)
 Pref (Net)
 Convert (Net]
 Other (Net)

Click here.
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Working with Custom Benchmarks

Exercise 4: Create a custom benchmark of Morningstar indexes

In Exercise 3 on page 18, you created a custom benchmark composed of several
commonly used indexes. In this exercise, you'll create a benchmark composed of
similar Morningstar indexes with the same weights. The benefit of using Morningstar

indexes is that all users have constituent rights to these indexes. Also, having a second
benchmark can offer a unique perspective on a client account.

Do the following:

1. On the header, click the Create icon, then select Custom Benchmark. The Creating
Custom Benchmarks window opens.

MORNNGSTIR Direct= =

%

Exercise 4: Create a
custom benchmark of
Morningstar indexes

Select this option.

( Q Search for Securities and Research..
Lists & Screens Client Accounts
Mame Type Last Modified Name il
[ ) |
Blockchain 08/23/2018 Scott Tucker 3
Stocks 1o Watch 08/23/2018 Richard Ha 3

2. Inthe upper-left corner of the Untitled area, click the Add icon. The Search dialog

box opens.
CREATING CUSTOM BENCHMARKS Save As | Hename Close
Untitled 01/31/2016 {% ¥ Allocation: Asset Allocation 01/31/2019  {F ™
| +| 10000 o
W Band {Nat
) Cash (MNet
Name Weight > M Pref [Net|
; . | Canvert (f
Edited 100.00 - e R
Morningstar Mod Tgt Risk TR USD - 0.00 .
Unallocated Cash 100.00 Eiisfing  Edited  Benchmark

Click here.

MAORNINGSTAR
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Working with Custom Benchmarks

Exercise 4: Create a custom benchmark of Morningstar indexes

3. In the Search field, type Morningstar US Market TR USD.

4. Inthe search results, click that index. The Search dialog box closes and Morningstar US

Market TR USD is added to the list in the Untitled area.
5. Repeat step 2 through step 4 to add each of the following indexes:

» Morningstar Gbl Ex US PR USD, and
» Morningstar US Growth TR USD
» Morningstar US Trgt Value TR USD

» Morningstar Mod Agg Tgt Risk TR USD

» Morningstar US Treasury TR USD.

< Note: Allow time for each index to load before adding the next.

CREATING CUSTOM BENCHMARKS

Untitled 04/30/2016

+

N
Recalculate

Name Weight > Price  Ticker
Edited 100.00 i
Existing — —  MSAA
Mamingstar Mod Tgt Risk TR USD 100.00 100 —
Unallocated Cash -
E — =3 R uTe)
1 Momingstar US Market TR USD 54790 WSBIcETE
2 Momingstar Gbl Ex US PR USD i’_' '_ :-,.—II
3 Moringstar US Growth TR USD - = =
4 Momingstar US Trgt Value TR USD = 822483 MSTART
5 Momingstar Mod Agg Tgt Risk TR USD = 2,598.48 MSGRT
6 Momingstar US Treasury TR USD = 5,077.18 MsSVLT

6. Inthe Weight column, change the weight of each index as shown in the following table:

< Note: Press Enter after each entry to move to the next row.

Index Name Weight
Morningstar US Market TR USD 40
Morningstar Gbl Ex US PR USD 20
Morningstar US Growth TR USD 5
Morningstar US Trgt Value TR USD 5
Morningstar Mod Agg Tgt Risk TR USD 25
Morningstar US Treasury TR USD 5

Note the highlighted selections.

MAORNINGSTAR
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Working with Custom Benchmarks

Exercise 4: Create a custom benchmark of Morningstar indexes

7. Inthe upper-right corner of the Untitled area, click Recalculate.

Close

o $

Click here to update
the allocation totals

Price Ticker

— MEAA

CREATING CUSTOM BENCHM... Save As

Untitled 04/30/2016
_|_

Name Weight

e

Edited 100.00

Existing 100.00

Mamingstar Mod Tgt Risk TR USD —

Unallocated Cash 0.00)

1 Mormningstar US Market TR USD 40.00

2 Momingstar Gbl Ex US PR USD 20.00

3 Momingstar US Growth TR USD 5.00)

4 Momingstar US Trgt Value TR USD 5.00

5 Momingstar Mod Agg Tgt Risk TR USD 25.00)

6 Momingstar US Treasury TR USD 5.00)

The weights match the weights
of similar indexes in Sample
Custom Benchmark.

METART
5 MGROT

MEAL. .
MSBIU. ..

8. In the upper-right corner of the window, click Save As. The Save As dialog box opens.

CREATING CUSTOM EENCHMARKS SaveAs | Rename | Close
Click here
Untitled 04/30/2016 % 7' Allocation: Asset Allocation 04/30/2019 £ N
Analytical View b
Holdings Allocation »~  Performance Returns/Risk butiom  Risk Factors ) + new Tab o=
Allocation = Momingstar Sector = D6/30/2019 = Karen Franklin L
Portfolio Bench... .
Name Vieight Weight +i- 1 Morningstar Indexes Benchmark
Technology {Met} 16.00 520
Healthcare (Met) 2.85 241 I
Cons Cyc {MNet) 11.11 1.01 ]
Fin Swes { 15.45 -6.33 I 1
ndustrials {MNeth 952 —z45 N |
Snergy (MNet) 5.57 —1.30 N |
Cons Def [(Met) 715 —3 gz N 1
Basic M (Net) a4.87 —z30 EE 1
Comm Svcs (Met) 3.40 51 W1
Real Estate {Net} 3.91 i I
Utilities {Met} 3.11 (I
] 20 a4m
9. Inthe Save As dialog box, enter Morningstar Indexes Benchmark, then click Save.
Save portfolio as
Marningstar Indexes Benchmarkl r—
4 N
L9 i
10. In the upper-right corner of the window, click Close.
Morningstar Direct for Wealth Management August 2019 23
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Working with Custom Benchmarks Exercise 5: Import a set of custom benchmarks

Another way to create a custom benchmark is to import a set of custom benchmarks. Exercise 5: Import a set
In this exercise, you will import the following custom benchmarks from Microsoft Excel:  of custom henchmarks

» Moderate Custom Benchmark,
» Aggressive Custom Benchmark, and
» Conservative Custom Benchmark.

Do the following:

1. Download the Excel file for this exercise.

2. Hover the cursor over the Menu, then select Import. The Import page opens.

— Ment | Home

X LONE MORNINGSTAR Direct

Morningstar Research

Markets ch for Securities and Research... )
AMALYZE
[#i Create v Client Accounts [# Create
Type Last Modified Mame Last Modified
L Z— L
MANAGE List 07/29/2019 Joe Franklin 08/06/2019
e List 07/20/2019 ¢aren Franklin 07/30/2013 Note the
SRS ) highlighted selections.
creen 07/29/2019 Adam Fairchild 07/24/2019
T T772a/ 2070 T/ 2072070
creen 19 02/12/2019
Alerts creen 19 02/08/2019
List 19 02/08/2019
EXTEND )
List 19 02/08/2019
Excel Add-In Lis 07419/2019 02/07/7019
Presentation Studio
Lis 07/19/2010 02/01/2018 7
Asset Allocation
Morningstar Direct for Wealth Management August 2019 24
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Working with Custom Benchmarks

Exercise 5: Import a set of custom benchmarks

3. From the Select File Type menu, select Custom Benchmark.

Preview Data

Select File Type

nwestment LISt

nvestment List with Custom Data

Account Holdings

Select this option.
Portfolio Return and Custom Data

4. Click Upload File.

Import

Preview Data

Custom gencnmark v ) [ 3 upiosd Fief @ | ik e

5. On your computer system, locate and double-click CustomBenchmarks.xlsx (the file
you just downloaded). The Import page opens, displaying mapping options.

MAORNINGSTAR
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Working with Custom Benchmarks

Exercise 5: Import a set of custom benchmarks

6. Inthe Column Mapping area, use the pull-down menus to make a selection for each
Unmapped column. Each unmapped column must correspond to a column in the Excel
spreadsheet. A selection for each column is required.

7. In the Exclude Header Row field, select First 1 row.

8. Inthe Weight Format area, select the option for Percentage.

CustomBenchmarks xlsx ¢ @

Column Mapping

Custom Benchmark 1D v Custom Benchmark Name Date v Holding Name v Weight % Scroll right
- - - . - - L - to see more
Custom Benchmark ID Custom Benchmark Name Date Holding Name (Morningstar Index] Weight I\/Iapping
CB123456 Moderate Custom Benchmark 2009-01-01 o Columns.
CB123458 Moderate Custom Benchmark 2009-01-01 20

Date Format

MM/DDAYYYY

Exclude Header Row

Security Mapping Option (3

First 1 row W

Weight Format
Make sure to

select these
options.

Decimal

® Percentage

9. Click Preview Data.

10. From the Preview page, click Preview Data Section under the
Custom Benchmark section.

Import

Import

Upload File > ( CustomBenchmark Vv )

Preview Data

Import Status

Model Portfolios
Data is ready for preview. View your results in Preview Dat

| Custom Benchmark I

o
W
L
i)
&
i
=
=

Data is ready for preview. View your results in| Prav

Note the highlighted selections.

MAORNINGSTAR
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Working with Custom Benchmarks

Exercise 5: Import a set of custom benchmarks

11. Select the Custom Benchmarks tab.

': Custom Bench.. v :' '
Securities (9) : Prices H 2z Be arks(3 Tlielk heria.
Matched Matched Matched 5g
Status  Security Name Security [dentifier Security Name  Security Ticker  Type
—
v New Securities (No Error
1 Marningstar US Inter Gov ... Marningstar...  MSBIIGTR Private
2 Morningstar US Core Bd T... Morningstar...  MSBICBTR Private F
12. To select all three custom benchmarks, click the circle to the left of New
Custom Benchmarks.
(" custom Bencn..v ) [ (_ Back ) w
8 8 Price: H 27 Custom Benchmarks(3)
[ Status  Custom Benchmark D Custom Benchmark Name mport Date/Time
—
| o | v New Custom Benchmarks (o Error) Click here to
[ 1 CB123455 Moderate Custom Benchmark 2019-08-07 10:2... select all three
o CRZ34567 Aggressive Cusam Senchmark 20190801 10:2,.. | custom benchmarks.
] 3 CB345678 Conservative Custom Benchmark 2019-08-01 10:2....

13. Click Import. A notification dialog box opens.

14. In the upper-right corner, click the X to close the dialog box.

Good news, your custom benchmark has (have) imported
successfully. To see your custom benchmark in action go to the

Portfolio Workbook. To import another custom benchmark, select your

Click here.

File Type and click Upload.

MAORNINGSTAR
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Working with Custom Benchmarks Exercise 5: Import a set of custom benchmarks

15. Hover the cursor over Menu, then select Your Files > Custom Benchmarks. The
Custom Benchmarks page opens.

Home )

EXPLORE

Morningstar Research

MANAGE

¥ '-.":I ur

m

5

Workbool

[5F]

Policies Note the highlighted selections.

Custom Bemchmarks

Custom Scenarios
Column Sets
Grid Batch Reports

Grid Batch Schedules

Search for Securnt
Select a previously created Benchmark from the below table. To create or delete 3 Benchmark, use the controls
above
] Name ¥ Type ¥ Owner Last Modified Date
-—
[l Aggressive Custom Benchmark Editablz Me 08/01/2019
D 7 Conservative Custom Benchmark Editable We 08/01/2018
D 3 Moderate Custom Benchmark Editabla Me 08/01/2018
[l 4  Morningstar Indexes Benchmark Editable Me 07/16/2018
D 5 Sample Custom Benchmark Editable We 05/16/2019

All'your custom
benchmarks are
listed on this page.

Morningstar Direct for Wealth Management August 2019

MOHMNGSTAH © 2019 Morningstar. All Rights Reserved.

28



Working with Custom Benchmarks Exercise 6: Apply custom benchmarks to a client account

In this exercise, you will apply two custom benchmarks to the Karen Franklin account. Exercise 6: Apply
They will then be available to use for comparison when analyzing the account. custom benchmarks

@ Note: In this exercise, you will assign benchmarks from the Client Accounts page; however, it to a client account

can also be done from the Grid in the Client Accounts workbook.
Do the following:

1. On the header, hover the cursor over Menu, then select Client Accounts. The Client
Accounts page opens.

Menu = Home

EXPLORE
Note the highlighted selections.
Morningstar Research

Warkets

ANALYZE

Model Porifolios

MANAGE

EXTEND

m

(cel Add-In

sl

gsentation Studio

Asset Allocation

2. On the Client Accounts page, hover the cursor over the Karen Franklin row. The
Actions icon appears to the right.

Morningstar Direct for Wealth Management August 2019 29
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Working with Custom Benchmarks Exercise 6: Apply custom benchmarks to a client account

3. From the Actions menu, select Settings. The Account Settings window opens.

Client Accounts

[l ame ¥ Type
] ditable
] . El Editable
O Client Accounfts
| 7 Select this option.
] 5 Richared Adverry Quick Accoun
] 6 ark & Catherine Crane  quick
Ol 7 FaulDonahue quick Account | e
O g Charies Mack quick Account cuiaUE
MmHNlNGSTAH Morningstar Direct for Wealth Management August 2019 30
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Working with Custom Benchmarks

Exercise 6: Apply custom benchmarks to a client account

4. On the left side of the window, select Calculation. The Calculation fields appear in the

empty area.

5. Click the Benchmark 1 field. The Benchmark 1 menu opens.

6. Select User Created > Custom Benchmarks > Sample Custom Benchmark.

Account Settings

Marningstar Mod Tgt Rigk

No Benchmark @]

lone v Note the highlighted selections.

Benchmark 1

[E] User Created

US Dallar ¥

=
=) Custom Benchmarks

7. Click the Benchmark 2 field. The Benchmark 2 menu opens.

[ Sample Custom Benchmark |

8. Select User Created > Custom Benchmarks > Morningstar Indexes Benchmark.

Account Settings

~ o
uBners

Calculation >

Note the highlighted selections.

Sample Custom Benchmark

No SErchrrarkl

Benchmafk 2
tick-Free Prox <) User Created =
- : 4 Q f (=, Custom Benchmarks
Morningstar Cash TR U} =
|L|sar Created I\ T
i AD is » v
No Benchmark | {
 Custom Benchmarks > FWF(
Mode| Fortfolios > | | [Morningstar Indexes Benchmar]
Palici * o
Sl Sample Custom Banchmark

9. Inthe upper-right corner of the window, click Save. The window closes.

MAORNINGSTAR
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Working with Custom Benchmarks

What are the options for displaying benchmarks?

Not every chart and table support the display of benchmarks. Of the charts and tables
that can display benchmarks, some can display only one at a time, while others can

display both simultaneously. To learn which charts and tables are capable of displaying
benchmark(s) and which benchmark(s) are displayed by default, please read Displaying
Benchmarks in Client Accounts.

In this exercise, the Morningstar Sector allocation of the Karen Franklin account will be
compared to the Morningstar Indexes Benchmark.

Do the following:

1. On the Client Accounts page, double-click Karen Franklin. The “Select a workbook to
view the client account:” window opens.

N G 0 Sy

[==]

MName ¥  Type

i

Beverly Dennison  qyick Account Editzblz
Charles Mack quick Account Editable
Christine Hall - gyjck Account Editablz
David Franklin - quick Account Editzblz
Dennis Brandt quick Account Editable
Judith James gyick Account Editablz
Karen Franklin | guick Account ® Editable
Marga Franklin - uick Account Editablz

Double-click here.

2. Select Client Accounts. The Client Accounts workbook opens and displays the Karen
Franklin account on the Grid.

Read Only

Select a workbook to view the client account: X
Q. locats Type Owner Modified Created

Cliznt Accounts Portfolios  Merningstar  01/27/2017  01/26/2017
Read Only

Custam Portfolios  Morningstar  01/27/2017  01/26/2017

Benchmarks

Read Only

Grid View Portfolios  Morningstar  01/27/2017  01/26/2017
Read Only

Madel Portfolios Portfolios  Morningstar  01/27/2017  01/26/2017

Select this option.

What are the options for
displaying benchmarks?

Exercise 7: Compare the
Morningstar Sector
allocations of a client
account and a benchmark

MAORNINGSTAR
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Exercise 7: Compare the Morningstar Sector allocations of a client
Working with Custom Benchmarks account and a benchmark

3. In the Client Accounts workbook, click the Karen Franklin. The Analytical View opens
from the right.

4. Select the Allocation tab. In the Allocation chart, both the client account and
Benchmark 1 allocation data is displayed by default. The Historical Allocation chart
displays data for only the client account.

< Note: To see the donut charts for both the account and its benchmark, you might need to
expand the Holdings Analysis chart or widen the browser window.

Select this tab.

Tl Analytical View X
Holdings |A!Jca:cr- » |Ferfa'"aw:e Return/F tion Risk Factors  Scenario Analysis  Equity @) 4 new Tab =)
a Allocation = Glabal Broad Category Group = 06/30/2019 » Karen Franklin o \2? -
Hame Click here
R to expand the
& 1 ¥aren Frankiin Portfalio Benchmark P .
fauy 817 © Equiy i chart to fill the
© Fired Incoms 0 Fixed Income 010 Analytical View.
Unclassified 000 Unclassified 9000
Historical Allocation » Asset Allocation = Karen Frankiin {5 S ]

W Stack (Met)
M Bond {Net)
Cash (Net|
W Pref {Net)
W Other (Net)

Jan Feb Mar Apr May Jun
2018

mDnn I I I I I I
000
Jul Aug Sep Oct Nov Dec
2018

5. By default, the Allocation chart shows the broad asset class allocation as a donut chart
or charts. To display Morningstar Sectors as a horizontal bar chart, do the following:

A. Click the Component Settings icon, then select Grouping > Morningstar Sector.
The Component Settings menu is displayed again.

Analytical View »
: X : s . : T Note the highlighted
Holdings Allocation v Performance  Return/Risk  Arr Risk Factors S 4+ Wew Tab = selections.
Allocation = Momingstar Sector = 06/30/2018 = Karen Franklin E e

Component Settings @ Grouping
Partfolio Date 3
06/30/2019 Q, Search All Groupings
Groupin e
Global Broad Category Group 2 Asset Allocation
Benchmark Economic Moat

Sample Custom Benchmark
Equity Region

"| Display Settings GICS Sector

Display ltems
1 Selected } Market Cap

Data View N Morningstar Sector |

Donut Chart Global Broad Category Group
Portfalio Benchmark Morningstar Category

O Besic Matls (Net) 213 . f 143 .
0 Cor 189 35
on 12.12 B.07
D 37 351
9::3 8.‘-;

1257 - © Healthcare (Net) [
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Exercise 7: Compare the Morningstar Sector allocations of a client

Working with Custom Benchmarks

account and a benchmark

B. Select Data View > Horizontal Bar Chart.

Analytical View

Holdings Allocation v Performance

Return/Risk

Attribution

Allocation = Mormingstar Sector = D6/30/2018 = Karen Franklin

© + NewTab H

E@wz’*

Component Settings

Portfolio Date
06/30/2019

Grc-Lpiné
Global Eroad Category Group

Note the
highlighted
selections.

Benchmar
Sgincpqle Eé:ujstnm Benchjmark @ Data View
Dioptay Settings Danut Chart
Display Iter
1lséli\c1eed-ns Stacked Bar Chart
Danr?utE:hart I—- Haonizontal Bar Chart
Portiolio Benchmark Table
O Besic Matls (Net) 248 & © Besic Matls iNet) 143" Bk
O Comm Sves [Nat) 183 © Comm Svcs [Net] 55
Cons Cyc [Net) 12.12 Cons Cyc (Net) B.07
O Cons Def [Nt 327 © Cons Def (Net] 351
O Energy [Net} 427 : { 224
O Fin Svcs [Met 912 O Fin Sves [Net} £.13
O Healthcare (Net) 1227 - O Healthcare (Met) 639
C. Click away from the Component Settings menu to close it.
Analytical View 54
The benchmark is
Holdings Allocation v Performance  Return/Risk  Atribution  Risk Factors S 4 New Tab =] represented by a vertical line
superimposed on the bars
Allocation = Momingstar Sector = 06/30/2079 = Karen Franklin o e which represent the
Morningstar Sectors.
Portfolio  Bench. .. "
Name Weight Weight +/- | | Sample Custom Benchmark
Technolagy {Net| 22.80 10.76 1204 |
Healthcare [Met) 1227 ag 527 |
Cons Cyc{Net) 1212 6.07 6.04 |
Fim Svcs (Met) 812 8.1% 0.97 (.
ndustrials {Net) 7.06 546 1.60 |
Energy (Net) 427 2.2 204 IR
Cons Def [Net] 327 351 -0.23 (W
Basic Matls (Net 248 1.43 105 |
Comm Svcs (Net) 1.88 155 03¢ W
feal Estate (Met) 0.58 205 —137 (]
Utilities {Net) 030 178 -1ag |l
1] 20 40

MAORNINGSTAR
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Working with Custom Benchmarks

Exercise 7: Compare the Morningstar Sector allocations of a client

account and a benchmark

6. To display Benchmark 2 (Morningstar Indexes Benchmark), click the Component
Settings icon, then select Benchmark > Portfolio Benchmark 2.

Note that you can select Portfolio Benchmark 1 or Portfolio Benchmark 2, but not both.

Analytical View X
Holdings  Allocation v Performance  Return/Risk bution  Risk Factors New Tab Note the
= ©+vewe H highlighted
Allocation = Mormingstar Sector = 06/30/2018 = Karen Franklin Ell'—-’“ <+ selections.
Portfolio  Bench Component [Settings
= e Samnla Tt 2a ~
Name Weight  Weight +/- 1 Sample Custom Be I @) Benchmark
04/30/2019|
Technology (Net 22.80 10.76 1204 o e Q. searcn for Benchmarks
Healthcare {Met) 1227 £.99 527 B = Holdings Summary
Cons Cyc{Net) 1212 6.07 6.04 1 ﬁ.ffamgpm
Fin sues 912 B.15 057 P—
ndustrials {Net) 7.08 545 150 R Sample Custom Benchmark T .
Energy (Met) 417 2.24 204 Il Currency . \
i US Dollar Mo Benchmark
Cong Def (Net) 327 351 -0.zz NI
Basic Matls {Net) 248 143 105 W
Comm Sucs (Net) 188 155 04 M
Real Estate {Netl 0.8 205 -137 b
Utiities {Net) 030 178 -148 11
0 20 40
7. Click away from the Component Settings menu to close it. Note the Benchmark 2 sector
allocations and compare them to the client account.
Analytical View =
Holdings Allocation v Performance  Return/Risk  Atiribution  Risk Factors S + New Tab H
i ! I ar f30/2 # ankiir :':} = VB-
Allocation = Momingstar Sector ® D6/30/2019 » Karen Franklin If you expanded
ECRE il the chart, click
ortfolio  Bench. .. R here to collapse it.
Name Weight  Weight +- 1 Morningstar Indexes Benchmark P
Technology {Net 2280 16.00 650
Healthcare (Net) 12.27 985 241 T
Cons Cyc {Net) 12; 1.01 |
Fin Svos 912 15.45 -633 I I
ndustrials (Met) 706 957 -746 N |
Energy (Net) 427 557 -130 |
Cong Def (Net) 327 7.15 -3zz |
Basic Matls (Net) 248 487 -z3¢ W |
Comm Sucs (Net) 188 340 -151 W1
Real Estate {Net] 0.68 391 323 1 |
Utilities {Net) 030 i 28 1|
0 20 40
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Exercise 8: Compare the historical returns of an account and both

Working with Custom Benchmarks

of its benchmarks

Some charts and tables can display two benchmarks at the same time. In this exercise,
you will do that in the Historical Return chart.

Do the following

1. Select the Performance tab and make sure the Karen Franklin account is still selected.
2. In the Historical Return chart, note that both benchmark names are displayed in the
legend and in the chart.
< Note: The legend can be displayed at the top of the chart or on the right, depending on the
width of your screen and/or the Morningstar Direct window.
3. To better focus on the Historical Return chart, expand it.

Partfolio Analysis |

*Client Accounts

Exercise 8: Compare the
historical returns of

an account and both

of its henchmarks

Historical Return = Maonthly ® 07/01/2018 - 06/30/2013 = aren Franklin

m:) Analytical View > | Select this tab.
Holdings  Allocation | Perfi Return/Risk A Risk Factors  S4g) \ew T: =]
Market Value = 07/01/2018 - 06/30/2018 = USD = Karen Franklin (o N AN
Name
i
= 162,520.41 Karen Franklin
@ 1 Karen Frankiin
ok oA ~— " /
—_— .fy oty & o =3 X = /-FTVA“F 'J\'“\._Ir'w .
13718 3¢ AL, Click here to
Ve i expand the chart
11311627 ' to fill the
Jull Oct 1 Jan 1 Ao Analytical View.
2018 2013

3

MAORNINGSTAR
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a0 I M Karzn Franklin
B Mamingstar The account
400 Ind i
alall_ __mm ol e I wios || andboth it
e i benchmarks are
Barn!‘mark. . identified in the
300 legend and
Jul Awg Sep Qct MNov Dec Jan Feb Mar Apr May Jun |IIustrated n the
2018 2013 bar chart.
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Working with Custom Benchmarks Exercise 9: Hide a benchmark

A chart capable of displaying bath benchmarks also includes an option to hide one Exercise 9: Hide
or both. a benchmark

Do the following:

1. The Historical Return chart displays both benchmarks by default, but one or both can be
hidden. To display only Benchmark 1 (Sample Custom Benchmark), click the Component
Settings icon, then select Benchmark 2 > No Benchmark.

Historical Return = Monthly = 05/01/2018 - 04/30/2018 = Karen Frankiin o2 Note the
highlighted
.00 selections.
Component Settings
Time Period =
— 07/01/2018 - 06/30/2019 ’ () Benchmark 2
4.00 . _—
rrequency 5 7
- i i iMuntth I C& Searchfor Benchmark
- I s
= [Emm Saﬂ-ﬁ;le Tustom Benchmark X Uzer Created
: Benchmark 2 ] T
Mt?rcnlingasrtar Indexes Benchmark I‘K\ Portfelio Benchmark 1
Currency 3 \ Portfolio Benchmark 2
EI—— US Dollar
—4.00 PoMglio Attached Policy
Display Settings
- No Benchmark
—3.00 Display Items s
— - - - - - - - = 3 1 Selected
May Jun Jul Aug Sep Oct Nov Dec Jan e i
2018 2019 | Chart 2

2. Click away from the Component Settings menu to close it. Now the Morningstar
Indexes Benchmark is hidden.

Historical Return = Monthly = 05/01/2018 - 04/30/2018 = Karen Franklin O S
800 -
W Rt The account and
= Sample Custom Benchmark 1 are
Benchmark identified in the legend
and illustrated in the
400 bar chart.
- H=EE__nu_Hinm
0.00
-400
= s : : :
May Jun  Jul  Auwg Sep Oct MNev Dec Jan Feb  Mar  Apr
2018 2019
In what months (if any) did the account outperform the benchmark?
Did the benchmark experience a significant downturn at any time in the past year? If so,
how did the account perform during that time?
What is your overall assessment of the account’s returns over the past year, compared to
Sample Custom Benchmark?
MmHNlNGS.[AH Morningstar Direct for Wealth Management August 2019 37
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Exercise 10: Compare the Sustainability Ratings Analysis of a client

Working with Custom Benchmarks

account and both of its benchmarks

Suppose you want to use the Sustainability Ratings Analysis chart to compare the
Karen Franklin account to both benchmarks simultaneously. Unfortunately, the
Sustainability Ratings Analysis chart can display only one benchmark at a time, and by
default, it displays Benchmark 1 (in this case, Sample Custom Benchmark).

However, when a second instance of the Sustainability Ratings Analysis chart is
created, each instance can display a different benchmark.

Do the following:

1. In the Analytical View of the Karen Franklin account, on the Tabs bar, select New Tab.
Anew tab opens. It is named Untitled 1 and displays no charts, tables, or research tools.
Also, the Edit panel automatically opens.

Exercise 10: Compare the
Sustainability Ratings
Analysis of a client
account and both of

its benchmarks

Portfolio Analysis | *Client Accounts v Search for Securities and Research...
Holdings  Alocation  Perfomance y,  RemmvRisk - Amriouton  Risk Fact@+ New & B Click here.
Market Value = 08/01/2018 - 07/31/2019 » USD » Karen Franklin PE S
B Name
. = Karen Franklin
@ 1 ¥aren Franklin

153.094.87

2.

In the Edit panel, scroll down to the Sustainability area. Drag Sustainability Ratings
Analysis from the Edit panel and place it in the empty area of the Analytical View.

Portfalio Analysis | *Client Accounts

Analytical View

e ario Analysis  Equity Sustainability Correlations Research  Notes | Untitled 1

your analysis.

Drag & drop charts, tables, and research tools to

customize

Note the name
of the new tab.

Drag this to
the left.

ty Ratings Analysis

Morningstar Direct for Wealth Management August 2019
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Working with Custom Benchmarks

Exercise 10: Compare the Sustainability Ratings Analysis of a client

account and both of its benchmarks

3. Tocreate a second instance of the chart, drag Sustainability Ratings Analysis from the
Edit panel and place it to the right of the existing chart.

NewTsp  EM @
&% Drag & drop charts, tables, and research tools to
= customize is
Hgh ®)*
Above .ivé.'age ®
Sample Custom Benchmark 4552 ) Drag this. ..
D A kot O Karen Franklin I
Below Average =T Below Average -
~ E;'E‘fc”':' — Controversy = Sustainpbility .
S 5206 7.04 45.02
el et 80%ofAUM 0] .- tohere.
Totes =
4. At the top of the Edit panel, click Done to close it.
Two instances of the Sustainability Ratings Analysis chart are displayed. Note that each
instance displays the same data— Karen Franklin and Sample Custom Benchmark.
< Note: To see both charts in full, you might need to widen your browser window.
Analytical View X
™ RiskFactors  Scenario Analysis  Equity  Sustainability Correlations  Researc otes  Untitled 1 5% Mew Tab H
Sustainability Ratings Analysis » US fquity La... & @ ¥ Sustainability Ratings Analysis = US Equity Larg... & @ 8
20000 Y =TT
High High
sl Loy
Above Average
oo =T, Both
Py it instances
verage Average e
Sample Custom Benchmark Sample Custom Benchmark
@9 o . 28 (6] -
Below Averans Karen Franklin Below Average Karen Franklin
. =l =l
Portfolic ESG 52.06 Portfolio ESG 52.06
- — Contraversy 04 || ey — Controversy 7.04
Vi Sustainability 45.02 || |ow Sustainability 45.02

MAORNINGSTAR
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Working with Custom Benchmarks

Exercise 10: Compare the Sustainability Ratings Analysis of a client
account and bath of its benchmarks

5. Inthe right chart, click the Component Settings icon, then select Benchmark >
Portfolio Benchmark 2.

Analytical View

Above A'.'érage

Sustainability Ratings Analysis

Equity

aCEnario Analysis

US Equity La..

. 2 E

Sustainability Ratings Analysis = US Equity Larg...

Component Settingy

Global Category
US Equity Largg Cap Blend

X
H
(KN
Note the
highlighted
selections.

Benchmark G_) Benchmark
Sample Custom Benchmark =
DO Display Settings Q se 2e
Average Display [tems
1 Selected
............................................. P
oo & Sample Custom Benchmark PN o |on
Below Average farea bankin Below Average S NcraneIm
G ity No Benchmark
Portfolio ESG 52.06 Portfolio ESG TZ U0
o — Controversy 704 ||y — Controversy 7.04
Low Sustainahility 502w Sustainability 45,02
6. Click away from the Component Settings menu to close it.
Note the benchmark and account information in the legend.
Analytical View 18
# RiskFactors Scenario Analysis Equity Sustainability Correlations Research Motes  Untitled 1 83 ew Tab =
Sustainability Ratings Analysis = US ouity La... &% @ ¥ Sustainability Ratings Analysis = US Equity Larg... & [
Each chart
displays the
selected
oo benchmark in the
A'D . legend and as a
Average dotted line.
B rrerel] | R

Below Average

Low

Karen Franklin

Below Average

Morningstar Indexes Benc...

Karen Franklin

o e
Portfolio ESG 52 06 = . The account’s
— Contraoversy 0 || @ Portfolio ESG 5208 Sustainability
Sustainahility 8502 | gy — Controversy .04 | Rating s displayed
Sustainability 45.02 in the legend and

represented by

a circle in both
charts.
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Exercise 10: Compare the Sustainability Ratings Analysis of a client
account and bath of its benchmarks

Working with Custom Benchmarks

7. (Optional) If you want to save the new tab (Untitled 1), you must save the tab and then
use Save As to save the workbook. Do the following:

A. On the Tabs bar, hover the cursor over Untitled 1.
B. From the menu, select Rename.

Analytical View pL4
# FRisk Factors  Scenario Analysis  Equity Sustainability Correlations  Research  Motes ew T =
Note the
Sustainability Ratings Analysis  US fquity Large Ca...  &F @ & Sustainab g 203, @O O highlighted
selections.
;|i-;|1 .
C. Name the tab My Custom Tab.
D. To save the workbook, hover the cursor over the workbook name (Client Accounts).
E. From the menu, select Save As. Note that Save cannot be selected.
Analytical View
L Workbook Note the
& Fouity Sustain o o] Motes  Aszocizted Accounts Wiy Cusiom Tab v 6% T highlighted
b e Create Nets T e T e = selections.
Sustainability Rating  Open 3 Sustainahility Ratings Analysis * U & X
EYYT Save 200

High

High

. . . Note the
@& - Workbook Analytical View X | highlighted
eate Ne & Sustainability Researt e v 8 ew T i=] selections.
[ e Sustainability Ratings Analy SN bility Ratings Analy o0 8
ame
] ¥aren Frankiin oeo0
High
8. Name the workbook My Custom Workbook and click Save
Morningstar Direct for Wealth Management August 2019 vy
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Using an Investment Policy Overview

Using an Investment Policy

An investment policy serves as a blueprint for investment plans. How much should a Overview
client invest in equities versus fixed income versus commodities versus cash, or other

asset classes? For the equity portion, how much will be in US stocks versus

international stocks? Small/Mid-Cap versus Large Cap holdings? Value versus growth?

An investment policy is designed to communicate this path.

Morningstar Direct for Wealth Management allows you to create custom policies to
document your firm’s various investment strategies. Not only can an investment policy
be used to compare a client account’s alignment to asset allocation lineups and
performance outcomes, but also to conduct total portfolio attribution for a client
account to determine if adjustments should be made, either to asset classes or the
managers selected.

This section covers the following topics and exercises:

» What is involved in creating an investment policy? (page 43)

» Exercise 11: Create an investment policy and its Level 1 asset classes and proxies
(page 44)

» Exercise 12: Add a level for Morningstar Category (page 46)

» Exercise 13: Create the Level 2 asset classes and proxies (page 47)

» Exercise 14: Assign weights to the Level 2 asset classes (page 51)

» Exercise 15: Save an investment policy (page 52)

» Exercise 16: Create an investment policy from a custom benchmark (page 53)

» Exercise 17: Attach an investment policy to a client account (page 56)

» Exercise 18: Compare the allocations of the client account and the policy (page 58)

» Exercise 19: Use groupings to replicate a policy’s asset classes (page 61)

Morningstar Direct for Wealth Management August 2019 42
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Using an Investment Policy What is involved in creating an investment policy?

In this section, you will create an investment policy and apply it to a client account. What is involved
Global Broad Category, Morningstar Category, and Morningstar Institutional Category in creating an

are the levels initially available for a policy, but custom data points can be used to build investment policy?
policies instead of (or in addition to) these.

< Note: To create a policy based on custom data points (such as your firm's own asset class
lineups), the custom data point(s) must first be created from the Custom Data Management
page. The investments used in client accounts should also be mapped to these custom
data points.

For example, a policy could be created only at the Morningstar Category level. If you
don't intend to conduct total portfolio attribution at the Global Broad Category Group
level or otherwise use that asset classification for comparison purposes, then this asset
class grouping does not need to be created as a policy level.

The overall steps to creating an investment policy are as follows:

1. Create an investment policy and select the Level 1 (in this case, Global Category) asset
classes and proxies.

& Note: When creating a policy with only one level, go to step 4.

2. Add the Level 2 (in this case, Morningstar Category) asset class.
3. Select the Level 2 sub-asset classes and proxies.

4. Set the weights for the Level 2 asset classes. (These will automatically roll up to the
Level 1 grouping.)

5. Save the investment policy.

< Note: You can also create a third level in an investment policy.
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Exercise 11: Create an investment policy and its Level 1 asset
Using an Investment Policy classes and proxies

In this exercise, you will create an investment policy with four Level 1 asset classes and Exercise 11: Create
their proxies, as shown in the following table: an investment policy
and its Level 1 asset

Level 1 Asset Class: classes and proxies
Global Broad Category Group Proxy

Alternative ICE BofAML US High Yield TR USD

Equity S&P 500 TR USD

Fixed Income BBgBarc Aggregate Bond Treasury TR

Money Market BBgBarc US Treasury Bill 1-3 Mon TR USD

Do the following:

1. In the header, click the Create icon, then select Policy. The Policy Editor window opens.

Create
’ ity List
MORNINGSIAR Direct> =
| O, Search for Securities and Research.
Select this option.
Lists & Screens Client Accounts
Mame Type  Last Modified Name u
Blockchain List 08/Z3/2018 8
Stocks 1o Watch List 08/Z3/2018 Eri 8
2. Inthe Asset Class Level area, from the Level 1 drop-down field, select Global Broad
Category Group.
3. From the Name drop-down field, select Alternative.
4. In the Proxy column Search field, enter ICE BofAML US High Yield TR USD and select
it from the search results.
Untitled v 08/31/2018 v (_Losd Data v X
Asset Class Level
B Ay Note the highlighted selections.
Global Broad Category Group VI Lo
— { Atemative v |  |icE Borami us High vieid TR ust
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Exercise 11: Create an investment policy and its Level 1 asset

Using an Investment Policy

classes and proxies

Click the Add Asset Class icon. A new row appears.
From the Name drop-down field, select Equity.
In the Proxy column Search field, enter S&P 500 TR USD and select it from the

search results.

Untitled v 08/31/2018 v (_ LoadDaa v ) X
Asset Class Level
MName Proxy
- Tptal
Global Broad Category Group W
mative V] ICE BofAML US High Yield TR
| AddLevel ) Vl

8. Continue adding asset classes and their proxies, as described in this table:

Asset Class

Proxy

Fixed Income BBgBarc Aggregate Bond Treasury TR
Money Market BBgBarc US Treasury Bill 1-3 Mon TR USD
Untitled v 08/31/2018 v ( LoadData v ) 5

Asset Class Level

Click here to add an asset class.

Name Proxy
Level 1
Total
Global Broad Category Group W :
Alternative W |CE BofAML US High Yield TR
3 Equity v S&P 500 TR USD

Fixed Income W B regate Bond Treasur
Money Market v BBgBarc US Treasury Bill 1-3 Mar

The Name and Proxy columns
should look like this.

MAORNINGSTAR
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Using an Investment Policy Exercise 12: Add a level for Morningstar Category

Now that you have created the Level 1 asset classes and their proxies, you can create
the Level 2 asset classes. Do the following:

1. Inthe Asset Class Level area, click Add Level. The Level 2 drop-down field appears.

Untitled v 08/31/2018 v ( LoadData v ) X

Asset Class Level

Exercise 12: Add a level
for Morningstar Category

Click here to add a level.

Name Proxy
Level 1
Total
Global Broad Category Group W :
Alternative v |CE BofAML US High Yield TR
(@D Equity v §&F 500 TR USD
Fixed Income W BBqgBarc Aggregate Bond Treasur
Money Market W BBgBarc US Treasury Bill 1-3 Mar

2. From the Level 2 drop-down field, select Morningstar Category.

In the list to the right, the Level 1 asset classes (Name column) and proxies (Proxy
column) are displayed. Each Level 1 shows a row in which you will create its Level 2
asset classes (sub-asset classes).

Untitled v 08/31/2018 v ( LoadDam v ) X
Asset Class Level
i v Name Proxy
Total
Global Broad Category Group W
v SAliemative % JGEEG MU ekl Select Morningstar Category.
Morningstar Category v ¥ Equity v S&P 500 TR USD
—_ Select an Asset Class W Selecta Pro
i) v Fixed Income W BBgBarc Aggregate Bond Treas
Select an Asset Class W Select a Proxy
¥ Money Market W BBgBarc US Treasury Bill 1-3 NV
Select an Asset Class W Selecta Pro
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Using an Investment Policy

Exercise 13: Create the Level 2 asset classes and proxies

To create the Level 2 asset classes and proxies, do the following:

1. Inthe new row beneath Alternative, the empty field can be used as a Search field. Click
the empty Select an Asset Class field and type United States Long-Short Credit.
Select it from the search results.

2. Inthe Select a Proxy field, search for and select Morningstar Diversd Alt TR USD.

Exercise 13: Create the
Level 2 asset classes

and proxies

Untitled v  02/28/2019 v (( loadData v ) X
Asset Class Level +
¥ Name Proxy
Level 1
Total
Global Broad Category Group W
¥ Alternative W %) IGE BofAML US High Yield TR USD
: - . = Note the
Level 2 United States Long-Short Credit Marningstar Diversd Alt TR USD highlighted
Morningstar Catagory v v Equity v S&P 500 TR USD selections.
: ] ¥ Fixed Income i BBgBarc Aggregate Bond Treasury TR
3. Under Equity, in the Select an Asset Class field, search for and select United States
Large Growth.
4. In the Select a Proxy field, search for and select Russell 1000 Growth TR USD.
Untitled v 02/28/2019 v ( loadDaa v ) X
Asset Class Level +
¥ Name Proxy
Level 1
Total
Global Broad Catsgary Group v
Y Alternative W ICE BofAML US High Yield TR USD
Level 2 United States Long-Shart Credit v Morningst: ersd Alt TR USD
Maorningstar Category o ¥ Equity W S&P 500 TR USD
( . United States Large Growth v (©  Aussell 1000 Growth TR USD wi(;}tﬁli;hhied
¥ Fixed Income v BBgBarc Aggregate Bond Treasury TR selections.
Select an Asset Class v Selecta Pr
¥ Money Market W BBgBarc US Treasury Bill 1-3 Mon TR

5. To add another asset class under Equity, click the Add Asset Class icon, then from the
Add Asset Class menu, select Level 2 > Equity. A new row appears under Equity.

6 Level 2

Add Asset Class

al Broad Category Grou |,

Note the highlighted selections.
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Using an Investment Policy Exercise 13: Create the Level 2 asset classes and proxies

6. Inthe new row, search for and select United States Large Growth.

7. Repeat step 6 four times so Equity shows four rows to be filled in under United States
Large Growth.

Untitled v  02/28/2019 v (_loadData v ) X
Asset Class Level +
¥ Name Proxy
Level 1
Total
Global Broad Catsgary Group v
¥ Alternative v ICE BofAML US High Yield TR
Level 2 United States Long-Short Credit “ Morningstar Diversd Alt TR USD
Maorningstar Category o ¥ Equity W S&P 500 TR USD
United States Large Growth 4 Russell 1000 Growth TR USD
——— Select an Asset Class A% Selecta Proxy
. - - These are the rows
Select an Asset Class v Select a Proxy you just created.
Select an Asset Class A% Selecta Proxy
Select an Asset Class v Select a Proxy
¥ Fixed Income v BBgBarc Aggregate Bond Treas
Select an Asset Class W Select a Prox
¥ Money Market v BBgBarc US Treasury Bill 1-3 b
Select an Asset Class Select a Proxy

8. Inthe new rows, search for and select asset classes and their proxies, as shown in

this table:
Asset Class Proxy
United States Large Value Russell 1000 Value TR USD
United States Small Growth Russell 2000 Growth TR USD
United States Small Value Russell 2000 Value TR USD
United States Foreign Large Blend | MSCI ACWI ex US Momentum NR USD

¥ Equity W S&P 500 TR USD
United States Large Growth i Russell 1000 Grawth TR USD .
St : : The Equity Name and Proxy
United States Large Value A% Russell 1000 Value TR USD columns should look like this.
United States Small Growth A\ Russell 2000 Growth TR USD
United States Small Value A Russell 2000 Value TR USD
United States Foreign Large Blend A4 MSCI ACWI ex US Momentum NR USD
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Using an Investment Policy Exercise 13: Create the Level 2 asset classes and proxies

9. Inthe Fixed Income column Search field, search for and select United States High

Yield Bond.
10. In the Select a Proxy field, search for and select BBgBarc Aggregate Bond
Treasury TR.
¥ Fixed Income W BBqBarc Aggregate Bond Treasury TR Note the highlighted selections.
| United States High Yield Bond W BBgBarc Aggregate Bond Treasury TR |

11. To add another sub-asset class under Fixed Income, click the Add Asset Class icon, then
from the Add Asset Class menu, select Level 2 > Fixed Income.

Untitled v 08/31/2018 v (_Loag.

R
Asset Class Level (<) Level 2

Ljiernative

Level 1 Add Asset Class Equity Note the highlighted selections.

Global Broad Category Grou

| Level 2 >|’
pyel 7

12. Under Fixed Income, repeat step 11 to add one more asset class (row).

13. In the unassigned Fixed Income rows, search for and select asset classes and their
proxies, as shown in this table:

Asset Class Proxy

United States Intermediate-Term Bond | BBgBarc Aggregate Bond Treasury TR

United States Muni National Interm BBgBarc US Municipal 1-15 Yr TR USD

¥ Fixed Income W BBEgBarc Aggregate Bond Treasury TR

=

United States High Yield Bond W BBgBarc Aggregate Bond Treasury TR

The Fixed Income Name and Proxy
columns should look like this.

United States Intermediate Term Bond W BEgBarc Aggregate Bond Treasury TR
United States Muni National Interm w BBgBarc Municipal 1-15 Y1 TR USD
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Using an Investment Policy Exercise 13: Create the Level 2 asset classes and proxies

14. In the Money Market column Select an Asset Class field, search for and select United
States Prime Money Market.

15. In the Proxy column Select a Proxy field, search for and select BBgBarc US Treasury
Bill 1-3 Mon TR USD.

f
¥ Name Proxy
Total
v Alternative v ICE BofAML US High Yield TR USD W
United States Long-Short Credit = v Marningstar Diversd Al TR USD W
¥ Equity W S5&P 500 TR USD W
United States Large Growth W Russell 1000 TR USD W
United States Large Value Y] Russell 1000 TR USD 1%
United States Small Growth W Russell 2000 TR US W
United States Small Value W Russell 2000 TR USD W
United States Foreign Large Blend v MSCI ACWI ex US Momentum NR USD v
T Fixed Income W BBgBarc Aggregate Bond Treasury... |
United States Long-Short Equity v S&P 500 TR USD W
United States Intermediate-Ter... v BBgBarc Municipal 1-15 Yr TR USD W
United States Muni National Int... v BBgBarc Municipal 1-15 Yr TR USD W
¥ | Money Market W BEgBarc US Treasury Bill 1-3 Mon... A L e e
United States Prime Money Ma... v BBgBarc US Treasury Bill 1-3 MonT... columns should look like this.
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Using an Investment Policy Exercise 14: Assign weights to the Level 2 asset classes

Finally, assign a weight to each of the Level 2 asset classes. The weights must Exercise 14: Assign
total 100. weights to the Level 2

< Note: You don't need to enter weights for Level 1 because it automatically equals the sum of asset classes

its Level 2 asset classes.

To assign the weights, do the following:

1. If the Weight % column is not visible at the right side of the window, do one of
the following:

> zoom out
<& Note: In Chrome or Internet Explorer, zoom out by pressing <CTRL>+<-> one or more times

until you can see the Weight % column at the right.

» widen your browser window, or
» scroll right.

2. In the Weight % column (to the right of the Proxy column), enter the weight of each
Morningstar Category level (Level 2) as shown in the following table:

< Note: The broad category weights update as you add weights to the Level 2 asset classes.

Level 1 Asset Class:

Global Broad

Category Group Level 2 Asset Class: Morningstar Category | Proxy Weight

Alternative United States Long-Short Credit Morningstar Diversd Alt TR USD 10

Equity United States Large Growth Russell 1000 Growth TR USD 175
United States Large Value Russell 1000 Value TR USD 17.5
United States Small Growth Russell 2000 Growth TR USD 5
United States Small Value Russell 2000 Value TR USD 5
United States Foreign Large Blend MSCI ACWI ex US Momentum NR USD 20

Fixed Income United States High-Yield Bond BBgBarc Aggregate Bond Treasury TR USD | 10
United States Intermediate-Term Bond BBgBarc Aggregate Bond Treasury TR USD | 5
United States Muni National Interm BBgBarc Municipal 1-15 Yr TR USD 5

Money Market United States Prime Money Market BBgBarc US Treasury Bill 1-3Mon TRUSD | 5
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Using an Investment Policy Exercise 15: Save an investment policy

¥ Name Proxy Weight %
i o The Weight % column

¥ Alternative W IGE BofAML US High Yield TR USD v 10.00 should look like this.
United 5tates Long-Short Credit v Marningstar Diversd Alt TR USD v 10.00
¥ Equity W 5&P 500 TR USD s 65.00
United States Large Growth W Russell 1000 Growth TR USD v 17.50
United States Large Value A% Russell 1000 Value TR USD v 17.50
United States Small Growth W Russell 2000 Grawth TR USD v .00
United States Small Vaiue A% Russell 2000 Value TR USD v 2.00
United States Foreign Large Blend A% MSCI ACWI ex US Momentum NR USD W 20.00
¥ Fixed Income W BEgBarc Aggregate Bond Treasury TR W 20.00
United States High Yield Bond W BBgBarc Aggregate Bond Treasury TR W 10.00
United States IntermediateTerm Bond W BBg2arc Aggregate Bond Treasury TR W 3.00
United States Muni Mational Interm W BBgBarc Municipal 1-15 Yr TR USD v 5.00
¥ Money Market W BEgBarc US Treasury Bill 1-3 Mon TR ... 5.00
United States Prime Money Market W BBgBarc Municipal 1-15¥r TR USD W 5.00

To save your policy, do the following: Exercise 15: Save an

1. From the top-left corner of the window, click the Untitled drop-down field, then select investment policy

Save As.

|Un1it|eu:| vl 08/3

Asset C [ palicy Note the highlighted selections.

dename

Level 1

Save At

Global

2. Inthe text field, type Sample Investment Policy, then click Save.

[

Save Policy as

” Sample Investment Policy | | Name the policy

3. Analert opens to tell you that the policy has been saved successfully. Click Close.
4. In the upper-right corner of the Policy Editor window, click the X to close it.

< Note: Now that this policy is saved, you can easily create other policies by using the Save As
command to give this policy a new name, then change the weights, proxies, categories, or a
combination of all three.
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Using an Investment Policy Exercise 16: Create an investment policy from a custom benchmark

Another way to create an investment policy is to create it from a custom benchmark. In Exercise 16: Create an
this exercise, you will use the Aggressive custom benchmark, which you created in investment policy from a
Exercise 5 on page 24. custom benchmark

Do the following:

1. From the header, select Create > Policy. The policy window opens.

Portfolio Analysis | *Client Accounts

Cv1 B Analytical View
Holdings '  Allocation  Performance  Return/Risk  Attributio i=]
& Holdings Analysis = Holdings Summary = USD = 07/31/2013 o= Note the
o highlighted
A Eairchild Momin ions.
[ 1 Adam Fsircrild Lot Analystg selections
[1 2 Beveriy Dennison ¥ Name Ticker D) Rating
[ 3 Charles Mack
[ : s j:__,ﬂ j Karen Franklin = e —
i s :;_ .‘:_':_‘311 Sample Custom Benchmark — T —— - —
[ : -'E":'“ Brandt v EII]IJiT‘F' - e el —
6 Dennis Branct Workbook
[ 7 Joe Frankiin ¥ Large Blend — - -
= American Funds Fund. C ote 0 G
@ 3 Karen Franklin Frcen - o
0 N . ¥ Large Growth Grid Batch — -
0 i 2 American Funds Growth Fund A 8% Bronze
= o 3 American Fund 562 7406058 Gold
0 v Fixed Income — - -
& ¥ Short-Term Bond — — - —
[ 4 American Funds ST Bd Fd of Amer A ASBAX 10.80 563452 Bronze
0 ¥ Muni National Short — — - —
5 Amencan Funds Ltd-Term Tx-Ex Bd A LTEBX 37 0.665.89 Bronze
2. Click Load Data, then select Custom Benchmarks > Aggressive Custom Benchmark >
01/01/2009.
Untitled v 06/30/2019 v Note the highlighted selections.
Asset Class Level Load Data (<) Custom Benchmarks (<) Aggressive Custom Benchmark
ass Lev! [ 0y5t0m Benchmarks ? | |Aggressi'.'r: Custom Benchmari >| |E1 01/2009 |
Model Portfolios ? Conservative Custom Benchmark ’
) b Moderate Custom Benchmark ’
Select Asset Class Lev Asset Allocation Cases
from scratch. Morningstar Indexes Benchmark ’
e Sample Custom Benchmark ’
custom benchmarl
Data.
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Using an Investment Policy Exercise 16: Create an investment policy from a custom benchmark

3. Click Level 1, then from the menu, select Morningstar Category.

Untitled v 06/30/2019 v ((loadData v )

Asset Class Level

Name

Level 1

Total Note the highlighted selections.

Mprningstar's Asset Class

(hlobal Broad Category Group

Morningstar Institutional Category
Region Specific _

AIG Sector = =

4. In the Name column, from the Select an Asset Class menus, make a selection
according to the following table:

& Note: As you make each selection, that row moves into place in the list, so the next Select an
Asset Class menu is at the top of the list.

For this Proxy... Select this Morningstar Category...

Morningstar US Core Bd TR USD United States Intermediate Core Bond

Morningstar US Corp Bd TR USD United States Corporate Bond

Morningstar US Treasury TR USD United States Money Market-Taxable

Morningstar US Inter Gov Bd TR USD | United States Intermediate Government

Morningstar US Mid Val TR USD United States Mid-Cap Value

Morningstar Gbl Mkts xUS GR USD United States Foreign Large Blend

Morningstar US Small Cap TR USD United States Small Blend

Morningstar US Large Cap TR USD United States Large Blend

Morningstar EM GR USD United States Diversified Emerging Mkts
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Using an Investment Policy Exercise 16: Create an investment policy from a custom benchmark

5. Inthe upper-left corner of the window, click Untitled. From the Policy menu, select
Save As.

Untitled v | 06/30/2019 v (LosdData v )

Asset C | Policy -+
Name T -
Level 1 Note the highlighted selections.
Total
Mornit
United States Mid-Cap Value
( Add Level ) United States Intermediate Govg

United States Money Market-Tay
United States Corporate Bond
United States Intermediate Core

United States Forzsign Large Ble

6. Name the policy Aggressive Policy, then click Save.
7. When the notification opens, click Close.
8. Inthe upper-right corner of the window, click to X to close it.
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Using an Investment Policy Exercise 17: Attach an investment policy to a client account

As you know, an investment policy describes the process to be used by a financial Exercise 17: Attach an
advisor in making investment decisions. The financial advisor follows the terms of the investment policy to a
policy as part of effectively supervising, monitoring, and evaluating the investment client account

objectives of the client. The advisor should periodically review a client account’s policy
and monitor how well the account is meeting its abjectives. Applying a policy to a
client account makes it easy to use in such a review.

In this exercise, you will attach the Sample Investment Policy to the Karen
Franklin account.

« Note: A policy can be attached to multiple client accounts.

To attach an investment policy to a client account, do the following:

1. Onthe Morningstar Direct Home Page, in the Client Accounts area, click Karen Franklin.
The "Select a workbook” dialog box opens.

MORNINGSTAR Direct >

Lists & Screens # Create V Client Accounts # Create : )

Click the client account

= = : you want to work with.
ame ype  Last Modified Name Last Modified
| L
Moderate Investiole Bench. .. List 03/06/2019 04/22/2019
ETF-S&P 500 TR USD Screen 03/05/2019 Joe Franklin 04/22/2019
ETF Screen Screen 03/05/2019 Beverly Dennison 02/12/2018
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Using an Investment Policy Exercise 17: Attach an investment policy to a client account

2. Click Client Accounts. The “Select a portfolio list to view in this workbook” dialog
box opens.

Workbooks

Select a previously created Workbook from the below table. To delete 2 Workbook, use the control above.

] Name ¥ Type

U 1| Client Accounts) Read Only Portfolios Click here to open the

0 7 Custom Benchmarks ' Read Only Portfolios Client Accounts workbook.
] 3 FEquity Fund Read only nvesimants

[ 4 Fixed Income Fund - Read only Investments

] 5 Managed Investments (formerly Grid View) Read Only nvestmEnts

] 6 Markets - Equity Research Read only Investments

] 7 Markets - Qverview Read Only nvestments

] 5 Model Portfolios Read on v Partfolios

] 9 Multi-Asset Fund  Read on ¥ nvestments

3. Select All Client Accounts. The Client Accounts opens.

Select a portfolio list to view in this workbook <

All Custom Benchmarks

All Model Portfolios

All Client Accounts Click here

4. Hover the cursor over the Karen Franklin row. The Actions icon appears. Click the
Actions icon and select Settings. The Account Settings window opens.

Portfolio Analysis | Client Accounts

Total Total Total
Return Return Return
(¥TD - (BN - (1Y - mo-
/] Name mo-end)  mo-end) end)
faram Eromkli 2y 13 0 £
| RN =2 A i H Note the highlighted selections.
Account
Edit Holdings
MmHNlNGSTAH Morningstar Direct for Wealth Management August 2019 57

© 2019 Morningstar. All Rights Reserved.



Using an Investment Policy Exercise 18: Compare the allocations of the client account and the policy

5. On the left side of the window, select Calculation.

6. On the right side of the window, from the Pelicy menu, select Sample
Investment Policy.

< Note: A policy can also be used as a benchmark. This saves the time of creating a new
benchmark with the same holdings as the policy. If a policy is used as Benchmark 1, when the
client account is edited, the Editor window reflects data from the investment policy.

Account Settings Cance @
e ] Note the
Sample Custom Benchmark . \forningstar Indexes Benchmark L | | | highlighted
llone selections.
2018 Investmégnt Policy
' T _ = |Sa-n:£ nvestment Policy | W
Morningstar Cash TR USDE &4 () UUse Zero Retum
7. Inthe upper-right corner of the window, click Save. The window closes.
If a client account is edited, the account’s correlation to the policy could change. Exercise 18: Compare the
Comparing the account to the policy might reveal disparities to be addressed. allocations of the client

In this exercise, you will examine the allocations of the account against those of account and the policy

the policy.
Do the following:
1. In the workbook, click the name Karen Franklin, select the Equity tab.

2. Expand the Allocation chart.

Portfolio Analysis | Client Accounts

1) Analytical View X
@ fewma Risk Fac Scenario Ana nz@) + New Tao H
. ) Select
Style Box * Equity Holdings StyleB... %% @ &Y Equity Region Exposure = 05/30/20.., & 0 o this tab
B  Name :
& ] = . Val Bld Gwih
Karen Franklin _ ﬂ Weight % ‘
e W 50+
W 2548 ‘.
_ 1024
=01 3 i) 0-8
S 0 0
- ]
<-1.75% 1] 1.25%=

Holdings Analysis » Equity Statistic... & &3 & Allocation = Morningstar Sector # 0... & Click here to

Name Portfolioc  Bench... expand_the
Name Weight  Weight Allocation
Karen Franklin 5 o ! table.
9.1 -
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Using an Investment Policy Exercise 18: Compare the allocations of the client account and the policy

By default, this chart shows the Morningstar Sector allocations of the account (Karen
Franklin) and Benchmark 1 (Sample Custom Benchmark).

Analytical View x
@ fetun/Risk  Atribution  Risk Factors  Scenario Analysis  Equity v Sustainzi) 4 New Tab H
Allpcation = Morningstar Sector = 06/30/2018 » Karen Franklin (o e
Portfolio  Bench... -
Name Weight Weight +- | 1| Sample Custom Benchmark The benchmark
B . ) values are
echnaology {Met) 2280 10.76 1204 | represented by
Healthcare {Met) £.09 527 " f— vertical lines.
Cons Cyc {Net) 1212 6.07 £.04 1
Fin Sves (Net) 212 8.15 087 |
ndustrials (Met) 7.08 546 160 | I
Energy [Net) 4.27 224 Z04 | I
Cons Def (Met 327 351 -0.z23 |l
Basic Matls (Net) 248 143 105 |
Ccomm Sves (Net) 189 55 034 (M
Real Estate {Netj 088 20 -137 (1]
Utiities (Net) 030 178 -1a8 |11
] 1] 0
3. Todisplay the policy, click the Component Settings icon, then select Benchmark >
Portfolio Attached Policy.
Analytical View >
Note the
@ “cum/Risk  Amrioution  Risk Factors  Scenario Analysis  Eouity v Sustainz@) 4 New Tab H Eéglgcl[[?:r;[gd
Allocation = Mamningstar Sector = 08/30/2019 = Karen Franklin E B
Portfolio  Bench... Component Settings (<) Benchmark
Name Weight  Weight +- | =
Portfalio Date 3 a 7 -
Technology {Netj 22.80 10.76 12.04 04/20/2019 =BG 13 5
Healthcare {Net] 12.27 5.99 827 Grouping ; lssehiasiaa
Cons Cyc {Net) 1212 6.07 g.04 Morningstar Sector Bortfolio Be ‘1
Fin Sves (Net) 8.1z 815 047 ales POSTTiOn g o it
ndustrials {Net) 7.06 5.4 160 Net Paortfolio Benchmark 2
Energy [Net) 417 22 204 Benchmark 3 Portfolio Attached Palicy
Cons Def (Netl 177 351 073 Sample Custom Benchmark TET———
Basic Matls (Net) 24 143 5 Display Settings
Comm Sves {Net) 129 55 03¢ M
T N 40 e S s Display Items
teal Estate {Net) 0.68 2.05 37 | 1 Selected >
Utilties Net} 030 78 g 11—
] Data \iew 5
Horizontal Bar Chart
4. Click away from the Component Settings menu to close it.
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Using an Investment Policy Exercise 18: Compare the allocations of the client account and the policy

5. Examine the results.

< Note: Your results will differ from those shown in the screenshot.

In your results, when comparing the client account and the policy, in which sector(s) is
the account overweighted? In which is it underweighted?

6. Collapse the chart.

Analytical View o
@ “eturn/Risk  Awribution  Risk Factors  Scenario Analysis  Equity v Sustainzyg) 4 Mew Tab =]
Allacation = Momingstar Sector = 06/30/2018 = Karen Franklin ol o
The client account is
Portiolio  Bench... : g i
Name Weight  Weight +- | Sample Investment Policy overweighted in the
Technology sector...
[ Technolagy (Met) 2280 1262 018 [
Healthcare (Mgt 1227 804 4122
Cons Cyc {Net) 1212 7.35 473 |
Fim Swes {Met) 912 977 -0.15 |
ndustrials (Net) 7.08 6.73 033 I
Energy (Net) 427 2402 136 N
Cons Def [Net] 327 386 -p52 M|
2asic Matls (Net 248 1758 72
Comm Sycs (Wet) 183 104 -pps M ...and significantly
Aeal Estate iNet) 0.58 278 2 11 underweighted in the Real
e i - p—— ] Estate and Utilities sectors.
Utilities {Net) 0.30 228 —2.00
1] 20 40

Allocation = Morningstar Sector = 04/30/2019 = Karen Franklin Eqj |v_‘"| Click here to
collapse
Portfolic Benchmark . the table.

Name Weight  Weight +~ | Sample Investment Falicy

Technolagy {Net) 2288 1437 £52 [E———

Healthcare (Net) 1231 8Z7 M

Cons Cyc {Net) 1215 780 475 |

Fin Sucs (Met) 916 997 =032 I |

ndustrials (Net) 7.08 712 =004

Energy (Net] 478 107 N

Cans Def (Net| 123 445 -115 . |

Basic Matls {Net) 244 184 055

Camm Svs (Net) 180 203 -p13

Real Estate {Net) 0.68 259 -1.92 i1

Utilities (Net) 030 214 —1ss 11

0 20 an
MOHNINGSTAH Morningstar Direct for Wealth Management August 2019 60

© 2019 Morningstar. All Rights Reserved.



Using an Investment Policy Exercise 19: Use groupings to replicate a policy's asset classes

Exercise 19: Use
groupings to replicate
a policy’s asset classes

The policy’s groupings (or asset classes) provide additional lenses to examine a
client account. In the Holdings Analysis table, you cannot directly group holdings to
match the policy’s groupings, but you can recreate them.

The supported groupings in the Holdings Analysis table are as follows:

» Global Broad Category
» Morningstar Category, and
» Morningstar Institutional Category.

The Holdings Analysis table can also reflect groupings based on custom data points
created by you or your firm. The table supports up to five levels of grouping.

In this exercise, you will recreate an investment policy’s groupings in the Holdings
Analysis table.

< Note: To refresh your memory of the structure of the investment policy, review Exercise 14 on
page 51.
Do the following:
1. In the Client Accounts workbook, make sure the Karen Franklin account is selected.

2. Select the Holdings tab.Click the Component Settings icon, then select Grouping >
Select Grouping > Global Broad Category. The Grouping menu reappears.

Analytical View X
Holdings v  Allocation  Performance  Return/R Attrioutic Risk Factors e ew Tab H
- - ey 8 Note the
Holdings Analysis » Holdings Summary = USD = 06/30/2019 = Karen Franklin L highlighted selections.
Component Settings
Portfolin Date . | Morningstar
¥ Name Tickd p3/31/2010 #| Analyst Rating
Karen Franklin — | Column St o —
Camoin R . Holdings S
Sample Investment Policy = =
¥ Equity — || Grouping y| —
¥ large Blend . | edmying =
American Funds Fundamental Invs A ANCH Benchmark » | Gold
Sample Custon) Benchmark
¥ large Growth - -
2 American Funds Growth Fund of Amer AGTH Currency , | Bronze
- = .4 US Dollar AT
3 HMEncan rungs Wew ccanomy & adkd= 12010
¥ Fixed Income — | Display Settings =
¥ Short-Term Bond - -
4 American Funds ST Bd Fd of Amer A Aszd E;é;ﬁ;nk“" »| Bronze
¥ Muni National Short = + R
5 American Funds LidTerm TeExBA A | () Grouping LD ¥ © Grouping [ Done |
Select Grouping Vl
¥ Global Broad Category
1/3 Clear All Morningstar Categary
Morningstar Instiutional Catego

MAORNINGSTAR
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Using an Investment Policy

Exercise 19: Use groupings to replicate a policy's asset classes

3. Click Select Grouping again,

Asset Class).

then select Morningstar Category (the policy’s Level 2

(<) Grouping @& | | © crouping [ Done

| Select Grouping

¥ | I Note the highlighted selections.

¥ Global Broad Category

1/ Clear All Morningstar Institutional Categary

The Grouping menu reopens.

selected them.

The selected groupings are listed in the order in which you

(<) Grouping L Done J
Select Grouping v
il it Note the highlighted selections.
% Morningstar Categary
2/5 Clear &l

4. Click Done.

5. Click the Component Settings icon to close the menu.

The client’s holdings are now displayed according to the assigned groupings (matching

the groupings in the policy).

6. Scroll right to see more of the Holdings Analysis table.

Analytical View

¥ Name

Karen Franklin

¥ Equity
¥ Large Blend

Hold ngs v Allocation  Perf

Sample Investment Policy

¥

X
riomance  Retwrn/Risk  Atribution  Risk Factors @) 4 New Tab =
Holdings Analysis * Holdings Summary = USD = 06/30/2013 = Karen Franklin L8 A
Market Morningstar
Ticker Weight  Value(USD) Analyst Rating

—_—
= 100.00 14393428 —

Amencan Funds Fundamenial Invs A ANCFX 20.64 2970258 Gold

¥ Large Growth

In Equity (the
Global Broad
Category), the
account has one
fund in the
Morningstar
Category Large
Blend and

two in Large
Growth. In Fixed
Income, it has
one fund each
in Short-Term
Bond and Muni
National Short.

Scroll here.

2 American Funds Growth Fund of Amer A AGTHX 44 60 64,197.17 Bronze
3 Amencan Funds New Economy A AMNEFX 650 23751.18 Gold
¥ Fixed Income = B e
¥ Short-Term Bond — i i
4  American Funds ST Bd Fd of Amer & ASBAX 10.88 15,674.07 Bronze
¥ Muni National Short S E e
5  American Funds Ltd-Term Tx-Ex Bd A LTEBX 7.37 10,609.29 Bronze
I [

MAORNINGSTAR
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Assessing the Impact of Fees on a Client Account Overview

Assessing the Impact of Fees on a Client Account

Clients naturally wish to increase the value of their investments as much as possible, Overview
while paying the lowest possible fees. Morningstar Direct for Wealth Management
helps you calculate and project the following fees:

» Platform Fee %
» Holdings Fees %, and
» Total Portfolio Fee %

Including these fees in projections and proposals shows the full impact of changes to a
client account.

This section covers the following topics and exercises:

» What fees are charged to a client account? (page 63)

» Exercise 20: Add a platform fee to a client account or proposal (page 64)
» How can | view a client account’s fees? (page 65)

» Exercise 21: Display the fees in the Holdings Analysis table (page 66)

» Exercise 22: Change the expected one-year growth (page 68)

Clients are concerned about fees and expect transparency about the cost of owning an What fees are charged
account. Fees and how they are calculated can be one of prospect’s biggest concerns to a client account?
when comparing wealth management firms.

< Note: In Morningstar Direct for Wealth Management, fees are expressed as a percentage of
the value of the account.

The client account fees are defined as follows:

Fee Definition

Platform Fee | Annual ongoing fee charged at the portfolio level by the wealth
management firm. It is a forward-looking fee, which projects the fee for the
portfolio object over the next 12 months.

Holdings Fee | Most recent portfolio holdings annual fee (which is also the Prospectus Net
Expense Ratio). This value cannot be changed.

Total The sum of the platform fee percentage and the holdings fees percentages,
Portfolio Fee | assuming a certain return for the portfolio over the next 12 months. (A
return of 5% is the default value, but you can change this. See Exercise 22
on page 68.)

To learn more about how fees are calculated, please read How Are Client Account Fees
Calculated? in the Morningstar Knowledge Base.
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Assessing the Impact of Fees on a Client Account Exercise 20: Add a platform fee to a client account or proposal

Because the platform fee is preset and holdings fees cannot be changed, the platform Exercise 20: Add a
fee is the only one to be added to the account. platform fee to a client

To add a platform fee, do the following: account or proposal
1. Ina Client Accounts workbook, hover the cursor over the Actions icon in the Karen

Franklin row. From the Account menu, select Settings. The Account Settings

window opens.

Portfolio Analysis | Client Accounts

v, q -

Total Total Total

Return Return Return

(¥TD - (BM - (1Y - mo-

/] Name mo-end)  mo-end) end)
@ 1 ¥aren Franklin &) 13.98 13.88 4.44

Note the highlighted selections.

Account

Edit Holdings

2. Inthe Account Settings window, note that the Platform Fee % defaults to 0.00000. In the
Platform Fee % field, enter 5.

= Note: This value must be between 0 and 100.

Account Settings Cance Save
Genera *
Calculation None v
The value in this field is
a percentage.
; Fee % (D
D o | 0.50000 |

3. Click Save.
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Assessing the Impact of Fees on a Client Account

How can | view a client account’s fees?

When the platform fee has been added to the account, the information you need can
be easily displayed in the Portfolio Fees column set, which is available in the

following areas:

» the Holdings Analysis table, and

» the Portfolio Editor window.

In Exercise 21 on page 66, you will display the Portfolio Fees column set in the Holdings
Analysis table. It is also available in the Portfolio Editor window, as seen in the

following screenshot:

EDITING HOLDINGS FOR "KAREN FRANKLIN"

Karen Franklin 03/31/2016

[

How can | view a
client account's fees?

+ Component Settings B @ Column Set
| Partfolio Date S
¥ Name el 02/21/2016 > lisD Equity Style
: hma . Equity Sectors
Edited 100 perenmarc [ 0| S
Existing 100. 00 Sustainability
i ) - Column Set
Sample Investment Policy Asset Allocation  ~ N—| Product Invalvement
Unallocated Cash 0.b< 0 peturn Month End
¥ Equity 15.00 75,000.00
v United States Large Growth 55.00 55,000,00] T8I Quarter End
American Funds Growth Fund of Amer A 40.00 49,000.00| Risk Nonth End
2 American Funds New Economy A 15.00 15,000.000Portfolio Fees
¥ Large Blend United States 20.00 20,000.00
3 American Funds Fundamental Invs A 20.00 20,000.00
¥ Fixed Income 25.00 25,000.00
¥ Short-Term Bond United States 15.00 15,000.00
4 American Funds ST Bd Fd of Amer A 15.00 15,000.00
¥ Muni National Short United States 10.00 10,000.00
5 American Funds Ltd-Term Tx-Ex Bd A 10.00 10,000.00
I

Scroll down to the bottom
of the Column Set menu.

MAORNINGSTAR
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Assessing the Impact of Fees on a Client Account

Exercise 21: Display the fees in the Holdings Analysis table

Suppose a client wants to understand the cost of his or her investment decisions and
asks about the total portfolio fee associated with his or her account.

Or perhaps you're a strategist and you want to know an account’s total portfolio
fee so you can discuss it with the portfolio manager to fully understand the
manager’s strategy.

In both cases, the information you need can be easily displayed in the Holdings
Analysis table in a Client Accounts workbook, by using the column set Portfolio Fees.

The fees in the column set are as follows:

» Total Portfolio Fee % (the sum of the Platform Fee % and the Holdings Fees %)
» Platform Fee %, and
» Holdings Fee %.

Do the following:

1. In the Client Accounts workbook, make sure the Karen Francis account is highlighted,
then select the Holdings worksheet.

2. Inthe Holdings Analysis table, click the Component Settings icon.

3. From the Component Settings menu, select Column Set > Portfolio Fees.

Portfolio Analysis | *Client Accounts

Exercise 21: Display the

fees in the Holdings
Analysis table

Note the
highlighted
selections.

m. Analytical View
Allocation Return/Risk A Risk Fact @)
Holdings Analysis # Holdings Summary = USD = 06/30/2019 = Karen Frankiin
B Name
- Component Settings
/]
Name Portfolio Date
04/30/2019
Karen Franklin
Column Set

Samole ent Policy

Holdings Summary

Grouping
No Grouping
Benchmark

Sample Custom Benchmark

Currency

US Dollar

Display Settings

Display ltem

Karen Franklin

Equity Statistics
Sustainability

Holdings Risk

Partfalio Fees

Custom Classification
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Assessing the Impact of Fees on a Client Account Exercise 21: Display the fees in the Holdings Analysis table

4. Click away from the menu to close it. The Total Portfolio Fee %, Platform Fee %, and
Holdings Fee % columns are displayed at the far right of the table.

< Note: You might need to scroll right or widen your browser window to see all three fees.

5. Note that the Sample Custom Benchmark row shows no values because it is not a
holding in the account.

Analytical View e
Holdings v Allocation  Performance  Return/Risk  Attribution  Risk Factors @) 4 New Tab =
Holdings Analysis = Portfolio Fees » USD = D6/30/2018 » Karen Franklin A
This cell is blank because the
Market Total Portfolic  Platform  Holdings Holdings Fee % applies to
Name Value(USD) Fee % Fee % Fee % holdings, but not to the account
as a whole.
Karen Franklin 143,934.28 5.53 4.89 —
Sample Custom Benchmark - — — El_
1 American Funds Fundamental Invs & 29.702.58 = — 12
: : : = 8 = e = These cells are blank because
~Mmer= 0. - - 0.8 the Total Portfolio Fee % and
10.609.29 — - 0.04 Platform Fee % apply to the
4 American Funds Maw Economy A 23.751.13 - — 0.13 ﬁClcé).Um. bu}[hﬂogto ir;]dividkual
§ American Funds ST Bd Fd of Amer A @ 1567407 = - 0.07 01dings orthe benchmark.
|
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Assessing the Impact of Fees on a Client Account

Exercise 22: Change the expected one-year growth

In Exercise 21 on page 66, you chose to display the Portfolio Fees column set. That
selection added a new option—1 Year Expected Return % —to the Component
Settings menu for the Holdings Analysis table. With this option, the projected return
can be changed. This can illustrate to the client that as returns increase, fees also
increase (even at a fixed percentage). The cost of the account goes up.

Initially, the Total Portfolio Fee % is calculated assuming a one-year return of 5%.

Do the following:

1. In the Client Accounts workbook, make sure the Karen Francis account is selected an

the Holdings worksheet is displayed.

In the Holdings Analysis table, Total Portfolio Fee %, Platform Fee %, and Holdings Fee
are displayed at the far right.

< Note: You might need to scroll right or widen your browser window to see all three fees.

Exercise 22: Change
the expected
one-year growth

d

%

Analytical View =
Holdings v Allocation  Performance  Return/Risk  Atiribution  Risk Factors @) 4 New Ta =]
Holdings Analysis = Portflio Fees » USD = 06/30/2019 = Karen Franklin A
Market Total Portfolic  Platform  Holdings
l\lame Value(USD) Fee % Fea % Fee %o
Karen Franklin 143,934.28 | 5.53 4.BE‘| -
S —— = o = s These values
i sl blbal were calculated
1 American Funds Fundamental Invs A 29.702.58 = o 0.12 assuming a
2 American Funds Growth Fund of Amer A i i ¥ 0.28 one-year return
0,
3 American Funds erm Tx-Ex Bd A - — 0.04 of 5%.
4 American Funds New Economy A = el 0.13
5§ American Funds ST Bd Fd of Amer A (&) = = 0.07
2. Click the Component Settings icon, then from the Component Settings menu, select
1 Year Expected Return %. Note that the default value is 5.
3. Inthe 1 Year Expected Return % field, enter 6.
Analytical View =
Holdings v Allocation  Performance  Return/Risk  Amrribution  Risk Factors @) \aw Ta =
Holdings Analysis = Portfolic Fees » USD = D8/30/2018 = Karen Franklin &
2 Note the
Component Settings / dings highlighted
Name T fee % selections.
ortrolio Late b
Karen Franklin /2 e
Sample m Benchmark Column Set @ > =
1 American Funds Fundamental Invs A Foctiolio Fees 0| (=) 1 Year Expected Return L Done J
2 American Funds Growth Fund of Amer A 1 Year Expected Retum % v | 0 %
3 American Funds Lt ExBd A 5 \ 0
4 American Funds Grouping 3 ]
§ American Funds ST 8¢ 7 (| Mo Grouping 07
3enchmark 3
Sample Custom Benchmark e

MAORNINGSTAR
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Assessing the Impact of Fees on a Client Account

Exercise 22: Change the expected one-year growth

4. Click Done.
5. Click the Component Settings icon to close the menu.

Because the fees are expressed as percentages (rather than currency), you may not see
a change or the change may appear insignificant. However, when the those percentages
are expressed as dollars or another currency, the difference between 5% and 6% can be
substantial, especially when working with an account valued in millions of dollars.

To see an example of how the percentages translate to currency, please read How Are
Client Account Fees Calculated? in the Morningstar Knowledge Base.

These values
were calculated
based on a
one-year return

Analytical View e
Holdings v  Allocation Performance  Return/Risk  Aftribution  Risk Factors (@) -+ New Tab H
Holdings Analysis = Portfolio Fees » USD = 06/30/2013 » Karen Frankiin ]
Market Total Portfolio  Platiorm  Holdings
Name Value(USD) Fee % Fea % Fee %o
Karen Franklin 143,934.28 | 5.56 4.92 | -
rA 64.197.17 s = 08
s - - A of 6%.
3 A - - 0.13
4 - — 0.08
5 American Funds Lzd-Term Tx-Ex Bd A = == 0.04
|
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Editing a Client Account Overview

Editing a Client Account

A client account might require modifications to its holdings and/or weights due to Overview
changes such as the following:

» the client’s investment goals
» market conditions,
» job change or retirement.

To respond to these and other developments, holdings can be added and removed from
the client account.

This section covers the following:

» Exercise 23: Create a new portfolio date (page 71)

» Exercise 24: Remove a holding from a client account (page 73)

» Exercise 25: Add a holding to a client account (page 75)

» How can | add multiple holdings to a client account? (page 78)

» Exercise 26: Create a model portfolio by importing (page 78)

» Exercise 27: Import a model portfolio’s holdings into a client account (page 82)

» How can | compare a client account to other portfolio objects? (page 87)

» Exercise 28: Associate a model portfolio with a client account (page 87)

» \What charts and tables can display a client account and an associated
model portfolio? (page 89)

» Exercise 29: Compare the Global Broad Category allocations of a client account
and its associated model portfolio (page 90)

» Exercise 30: Compare the Morningstar Sector allocations of a client account
and its associated model portfolio (page 92)

» Exercise 31: Delete a client account (page 94)
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Editing a Client Account Exercise 23: Create a new portfolio date

Suppose Joe Franklin (who was a prospect at the beginning of this guide) has become Exercise 23: Create a new
a client. Your analysis shows that the account could gain larger returns by replacing portfolio date

one of the holdings. You create a proposal showing this and present to Mr. Franklin,

who agrees to the change.

Before making such a change to the account, be sure to create a new portfolio date.
This ensures that you can look back at the previous date’s holdings and weights.

Do the following:

1. In the Client Accounts workbook Grid, hover the cursor over Joe Franklin. The Actions
icon appears.

2. Click the Actions icon and from the menu, select Edit Holdings. The Editing Holdings
window opens.

Portfolio Analysis | *Client Accounts

ST q : -

Total Total Total
Return Return Return
(YTD - [6M - (1Y - mo-
B Name mo-end) mo-end) end)
B 1 Joe Franklin 16.15 7.04
Note the
highlighted selections.
Morningstar Direct for Wealth Management August 2019 Al

MOHMNGSTAH © 2019 Morningstar. All Rights Reserved.



Editing a Client Account Exercise 23: Create a new portfolio date

3. Inthe list of holdings, click the Component Settings icon, then select Portfolio Date >
Create From Existing Date. A new menu opens.

4. Select the date you want to use as the basis of the new date. In this case, only one date
is available (12/08/15). A new menu opens.

5. Inthe Holdings Date field, type yesterday's date.

< Note: In the Retain From 12/08/1205 field, leave Shares selected. The other option for this
field is Weights.[

EDITING HOLDINGS FOR "JOE FRANKLIN" Sawve Save As Rename Close
Joe Franklin 12/08/2015 | {'}l 7 Allocation: Asset Allocation 07/31/2019 £
+ Component Setting W Stock {Net Note the
M Bond {Net) highlighted
Portiolio Date selections.
bl Cash {Net)
Name IZ.I'IJB.I’EU'I : W Pref (Net)
Benchmark )
Edited Morningstar Mod Tjit Risk TRUSD ~ ~ W Camvert {Net)
o W Other [Net)
Existing Calumn Set y
Morningstar Mod Tgt Risk TRUSD  Asset Allocation
(<) Portfolio Holdings Date
Edit Current Date ? @l Create From Existing Date
(<) Create From Existing Date _
Lreate New Date ’ g Holdings Date
Create From Existing Date |> |';.-|:s-:[;15 » 08/05/2018
Delete Existing Date ? Retain From 12/08/2015
Open Date > Shares

6. Click Done.

7. In the upper-right corner of the Editing Holdings window, click Save. Don't close the
Editing Holdings window.
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Editing a Client Account

Exercise 24: Remove a holding from a client account

In this exercise, you will remove a holding from the account.

The Editing Holdings window should still be open.

Exercise 24: Remove

a holding from a

1. Hover the cursor over Hodges Pure Contrarian Retail. The Actions icon appears to the
right of the name.Click the Actions icon and select Remove from portfolio. The holding

is removed from the client account.

EDITING HOLDINGS FOR "JOE FRANKLIN"

Name Weight
ey v e

Edited 100.00
Existing 100.00
Morningstar Mod Tgt Risk TR USD =
Unallocated Cash =0.00

1 Baron Partners Retail 17.16
2 Brown Advisory Equity Income Adv 1343
3 Hodges Pure Contrarian Retail @ 1179

an Nt

4 Dlstein All Cap Value 2~
5 Hodges Blue Chip Eg Actions

Joe Franklin 08/05/2019 3

+ Recalculate

2

client account
Save Save As Rename Close
Allocation: Asset Allocation 04/30/2019 {:} N

109.24 M Stock (Net)
W Bond (Net)

Cash [Net)

- M Pref (Net)

M Convert {Net)
M Other (Net)
-109.24

Existing  Edited Benchmark

Investment Growth: 10K Growth 05/23/2018 - 05/22... {:} N

— bwsting  — kdited  — Benchmark

11,824.65

6 T. Rowe Price Emergil -
e |Hem0\fe from portfalio |
Franklin Total Return

o _ _ 10,000.00

8 T Rowe Price Summit mrurmapar i muy uea

9 Brown Advisory Emgerg Mkis Select Inv 491 8175.35

10 Cullen International High Dividend Retl 435 May 21 May 21
[ ] 2018

2. In the upper-right corner of the Editing Holdings window, click Save. Don't close the

Editing Holdings window.

Click here
to remove
this holding.

MAORNINGSTAR
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Editing a Client Account Exercise 24: Remove a holding from a client account

Note that the weight of Hodges Pure Contrarian Retail (11.79) has been assigned to
Unallocated Cash.

EDITING HOLDINGS FOR "JOE FRANKLIN"

Joe Franklin 08/05/2019 £
+
Name Weight >
- ¥
Edited 100.00
Existing 100.00
Morningstar Mod Tgt Risk TR USD =
[ Unallocated Cash 11.79| T E——
1 Baron Partners Retail 17.16
Z Brown Advisory Equity Income Adv 13.43
3 Olstein All Cap Value Adv 1091
4 Hodges Blue Chip Equity Income Retai 10.82
5 T. Rowe Price Emerging Markets Bond Adv 9.80
6 Franklin Total Return Adv 8.54
7 T. Rowe Price Summit Municipal Intm Ady 8.29
8 Brown Advisory Emgerg Mkts Select nv 491
9 Cullen International High Dividend Retl 435
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Editing a Client Account

Exercise 25: Add a holding to a client account

In Exercise 24 on page 73, you removed Hodges Pure Contrarian Retail from Joe
Franklin account. In this exercise, you will add iShares Core S&P 500 ETF to take

Exercise 25: Add
a holding to a

its place. client account
The Editing Holdings window should still be open.
Do the following:
1. In the upper-left corner of the Editing Holdings window, click the Add icon. The Add
dialog box opens.
Joe Franklin 08/05/2019 N
—|— Recalculate Click this icon.
Name Weight >
¥
Edited 100.00
Existing 100.00
Morningstar Mod Tgt Risk TR USD
Unallocated Cash 11.719
1 T. Rowe Price Summit Municipal Intm Adv 8.29
2 T. Rowe Price Emerging Markets Bond Adv 9.80
2. Inthe Add field, enter IVV. The results list displays more than one selection for iShares
Core S&P 500 ETF. Select the one traded on NYSE ARCA. The Add dialog box opens.
Add
I -Q L 25 Type IVV here.
MORNINGSTAR SECURITIES 10 MORE >
Name |dentifier Type Exchange
iShares Core SEP 500 ETF W Exchange-Trade NYSE ARCA SRRt
iShares Core S&P 500 £TF WV ExchangeTrade... BOLSA MEXICANA DEVALD...
iShares Core S&F 500 £TF WV ExchangeTrade. . SANTIAGO STOCK EXCHANGE
PORTFOLIOS NO RESULT
CUSTOM SECURITIES NO RESULT
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Editing a Client Account

Exercise 25: Add a holding to a client account

iShares Core S&P 500 ETF is now listed as a holding. Its weight and market value display

a dash (—).

EDITING HOLDINGS FOR "JOE FRANKLIN"

Joe Franklin 08/05/2019 N
=
) Market
Name Weight > Value{USD)
Y
Edited 100.00 12,534.57
Existing 100.00 12534 57
Morningstar Mod Tgt Risk . .. = =
Unallocated Cash 11.79 1,478.06
1 T. Rowe Price Summit Municipa. .. 8.29 1.038.75
2 T Rowe Price Emerging Market. 9380 1,22892
3 QOlstein All Cap Value Adv 1091 1,367 66
4 iShares Corg S&P 500 ETF = = o :
S - - The dashes indicate the holding
5 Hodges Blue Chip Equity Incom._. 10:82 1.355.68 has no weight or market value.
B Franklin Total Return Ady 854 1.070.61
7 Cullen International High Divide. . 435 945 17
8 Brown Advisory Equity Income .. 13.43 1,683.37
9 Brown Advisory Emgerg Mkis S_ . 491 61558
10 Baron Partners Retail 17.16 2,150.76

MAORNINGSTAR
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Editing a Client Account Exercise 25: Add a holding to a client account

3. Inthe iShares Core S&P 500 ETF row, click the dash in the Weight column.

4. Enter 11.79 (the weight currently assigned to Unallocated Cash and previously assigned
to Hodges Pure Contrarian Retail).

EDITING HOLDINGS FOR "JOE FRANKLIN"

Joe Franklin 08/05/2019 & N
+
. Market
Name Weight > Value(USD)
v
Edited 100.00 12,534.57
Existing 100.00 12,534 57
Morningstar Mod Tgt Risk ... = =
Unallocated Cash 0.00 0.24 Note the weights and market values
1 T. Rowe Price Summit Municipa. .. 229 1,038.75 for Unallocated Cash and iShares Core
2 T. Rowe Price Emerging Market. .. 930 1,228.92 SeFSILETE
3 Olstein All Cap Value Adv 1091 1,367 .66
4 i3hares Core S&P 500 ETF 11.79 147783
5 Hodges Blue Chip Equity Incom. .. 10.82 1,355.68
6 Franklin Total Return Adv 854 1.070.61
7 Cullen International High Divide. .. 435 545.17
8 Brown Advisory Equity Income .. 13.43 1,683.37
9 Brown Advisory Emgerg Mkts 3 4191 615.58
10 Baron Partners Retail 17.16 2,150.76

5. Inthe upper-right corner of the window, click Save. Then click Close.
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Editing a Client Account How can | add multiple holdings to a client account?

In Exercise 25 on page 75, you added a holding to the Joe Franklin account. What can How can | add
you do if you're in the following situation: multiple holdings

. . i ?
» You need to add multiple holdings to an account, and to a client account?

» The holdings aren’t available as a list but they are in a model portfolio.

Adding the holdings individually would be time-consuming, but if you have access to
the model portfolio, you can add its holdings to the client account.

In Exercise 26 on page 78, you will import a Microsoft Excel file as a model portfolio,
then in Exercise 27 on page 82, you will import the model portfolio’s holdings into the
Joe Franklin account.

In this exercise, you will create a model portfolio by importing a Microsoft Excel file. Exercise 26: Create
You will later import this model portfolio’s holdings into the Joe Franklin account. a model portfolio
by importing

Do the following:

@ Note: When using an Excel file on your own, be sure to first check the requirements for
importing an Excel file, found in Data Import Specifications.

To import an Excel file, do the following:

1. Download the Excel file for this exercise.

2. Inthe upper-left corner of the Home page, hover the cursor over Menu and select
Import. The Import page opens.

— Ment | Home

Rome ]

X LONE MORNINGSTAR Direct

Morningstar Research

Markets ch for Securities and Research... )

AMALYZE
cCounts [ Create v Client Accounts [# Create

& oCTEENS

Model Partfolios Type  Last Modified Name Last Modified
N - T L Z— L
— Lt 07/20/2019 Jue Frankiin 08/06/2019
e List  07/29/2019 Caren Frankiin 07/30/2019 Note the
S RS ) highlighted selections.
treen 07/29/2019 Adam Fairchild 07/24/2019
S i T TS Z0720TY
reen 19 02/12/2019
reen 19 02/08/2019
List 19 02/08/2019
L 19 02/08/2019
Lis 07/19/2019 ! 02/07/2019
L 07/19/2019 ™ ennis Bra 02/01/2018 ™
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https://advisor.morningstar.com/AWSOE/Training/DataImportSpecifications.pdf#page=11
http://morningstardirect.morningstar.com/clientcomm/ABC-Model.xls

Editing a Client Account Exercise 26: Create a model portfolio by importing

3. Atthe left side of the Import window, the Upload File option is selected. Click Select File
Type and select Model Portfolios. To the right of the Select File Type button, the Upload
File icon appears.

Import

Import

Upload File > ne v |

Preview Data

Select F'Ie Type - "
Note the highlighted selections.

r'.-sst*ls nt List

nvestrfent List with Custom Data

Custom Benchmark

4. Click Upload File. A navigation window opens.

Impart

Upload File % Account Holdings | |

o)

Click here.

Preview Data

5. On your computer system, locate and double-click ABC-Model.xls (the file you
downloaded). The Import page opens, displaying mapping options.

6. In the Column Mapping area, use the pull-down menus to make a selection from each
Unmapped field. Each unmapped column must correspond to a column in the Excel
spreadsheet. A selection for each column is required.

lodel Po -_":: a5 Yy ABC-Model xls oy G) Frm Data
Column Mapping Rese
Date v Mode! Portfolio Name Holding Name W Symbol/Ticker v Weight %| | yse the pull-down
menus to map
As of Date Model Name Name Ticker Weight each column to
= the these
2014-07-30 ABC Mode Vanguard Total Intema. .. WVEUS 10 selectionsin Date,
TR T £ i 73 Model Portfolio
2014-07- ABC M Imvesco BulletShares 2. .. BaJL 15 :
2014-07-30 ABC Mode VESCO € J Narme, Holding
4 Name,
Symbol/Ticker,
_ _ _ and Weight %.
Security Mapping Option  (3) Exclude Header Row Date Format Nleight Format
Exclude [nactive Investments First 1 row v MM/DDAYYY W Ddim
[ Aut Select Didest Share § Percentage
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Editing a Client Account Exercise 26: Create a model portfolio by importing

7. In the Exclude Header Row field, make sure First 1 row is selected.
8. From the Date Format menu, select MIMI/DD/YYYY (or the date format you want to use).

9. Inthe Weight Format area, select Percentage.

el Fo —fj 0s ABC-Model xIs X @ Preview Data
7 Calumn Mapping Rese
Date % Model Portfolio Name Holding Name W Symbol/Ticker W Weight %
Az of Date Mogel Nams Name Ticker Weight Match these
—— e i e — = selections in
2014-07-30 ABL WOCe vanguard lotal Intema. .. VAo L1} Exclude Header
2014-07-30 ABC Mode Invesco BulletShares 2. .. gL 15 Row, Date Format,

and Weight
b Format.
Security Mapping Option  (3) Exclude Header Row Date Format Nigight Format
First 1 row v MM/DDAYYY W Decima
® Percentage

10. In the upper-right corner of the window, click Preview Data. The Import Status
window opens.

11. Under Model Portfolios, click Preview Data Section.

Import

Impart
Upload File ';’ Madsl Portfolios v
Preview Data

Import Status

Investment List

Data is ready for preview. View your results in Preview Data Section
Account Holdings
Data is ready for preview. View your results in Preview Data Section.

Muodel Portfolios

e e et e AR e e
Uata I1s ready 1or preview. View y

m

Click here.

In the Preview Data window, the holdings are listed as individual securities. Those listed
in the New Securities section have not been imported before. Those listed in the Existing
Securities section have been previously imported.

Morningstar Direct for Wealth Management August 2019

MOHMNGSTAH © 2019 Morningstar. All Rights Reserved.

80



Editing a Client Account Exercise 26: Create a model portfolio by importing

Some of the securities from the Excel file might be listed under Existing Securities. One
solution is to compare the new securities against the Excel file to make sure they're all
listed. However, that can be time-consuming, especially if a large number of securities is
being imported. It's quicker to view the import as a model portfolio.

12. Near the top of the window, select the Model Portfolios tab. On this tab, model
portfolios are shown, rather than individual securities.

|, Model Portfolios v

Securities (42}
Select the
Model
Portfolios tab.

v New Securities (No Error

1 Saba Closed-End Ful Saba Closed. ..

Exchange-frad... USD
2 Vanguard Total Inter VanguardTo... VXUS Private Fund usD
3 American Century P American C._. BPRXX Money Marke. .. Uso

4 iShares Russell 2000

13. Select ABC Model by clicking the circle at the left of its row, then in the upper-right
corner of the window, click Import.

(_ Model Portfolios v ) ] [ Back | @

securities (42 Prices Holdings {56 Muodel Portfolios (6)

Status Model Portfolio Numbe Model Portfolio Nam Impart Date/Time
—
v New Model Portfolios (Mo Error =
|£| 1 ABC MODEL ABRC Model 2019-07-30110:7.. Clickhera.
2 MODERATE Moderate 20190716 09:5. ..
3 W¥XZHA X235 2019-04-22 1585...
¥ Existing Model Portfolios (Mo Error
1 MODEL12345 Conservative 2018-08-10 114
2 MODELZ3456 Income 2018-08-10 114
3 MODELSG783 Growth 2018-08-10 114

14. A message opens, announcing the account was imported successfully. In the upper-right
corner of the message, click the X to close it.

Good t has (have) imported fully. T
ood news, your account has (have) imported successfully. To see I:[ Fr—
your account in action go to the Portfolio Workbook. To import
another account, select your File Type and click Upload.
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Editing a Client Account Exercise 27: Import a model portfolio’s holdings into a client account

Now that the ABC Model is available to you, you can add its holdings to the Joe Exercise 27: Import
Franklin account. a model portfolio’s
holdings into a

Do the following: .
g client account

1. In the Grid, hover the cursor over the Joe Franklin account and from its Action menu,
select Edit Holdings. The Edit Holdings window opens.

Portfalio Analysis | *Client Accounts

Total Total Total

Return Return Return

(YTD - [BM - {1Y - mo-

/] Name mo-end] mo-end) end)

B 1 Joe Franklin | @l 16.15 16.19 7.04
Account

Note the
highlighted selections.

Generate Portfolios Comparison Report

2. In the upper-left corner of the Editing Holdings window, click the Add icon. The
Add dialog box opens.

3. Select From Model Portfolio Holdings. The Model Portfolio List opens.

EDITING HOLDINGS FOR "JOE FRANKLIN™

Joe Frankfin 08/05/2019 AN
] D
Add
shares Price
From Investmen List > - -
From User Created Portfolios } 0.00 1.00 Make sure you select
folio Holdings 5 a0 ST this option.
l 380,05 1280
4. Select ABC Model. A new menu opens.
The date or dates of the model portfolio’s most recent update(s) are shown below the
Search field. Keep in mind that the holdings might change from update to update.
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Editing a Client Account

Exercise 27: Import a model portfolio’s holdings into a client account

5. Click the date when the portfolio contained the holdings you want.

(<) Model Portfolio List

(£) ABC Model

Big 4 Model Portfolio
Big Tech Portfolio
Conzervative

Custom Classification
Growth

Income

Income ETFs Portfolio

Q, Search Mode
{ )
5 Year Plan \ /
|AB': Model | 7130/2014

Select this option.

When the menu closes, the holdings from ABC Model have been added to the Editing
Holdings window. However, they have retained their weight percentages from the ABC
Model, which means the weight percentages of the Joe Franklin account no longer add

up to 100.
Joe Franklin 03/05/2019 {3
=
Market
Name Weight > Value(USD) > Shares > Price
- T
Edited 100.00 552,825.10 = =
Existing 100.00 552,825.10 = =
Morningstar Maod Tgt Risk TR USD = = = =
Unallocated Cash | —|IJD.I]I]| —552,825.10 —-552,825.10 1.00
1 Baron Parters Retail 1945 107.537.97 297807 BT &ﬂfgfgﬁ;ﬁfygﬂg&,
2 Brown Advisory Equity Income Adv 15.23 84,168.62 6.680.05 12,60 a value other
3 iShares Russell 2000 Value ETF 15.00 82923.76 882.17 24.00 than 0.
4 |nvesco BulletShares 2021 HY Corp Bd ETF 15.00 82923.76 3.554.38 23.3:
5 Vanguard 5&F 200 Value ETF 1250 69,103.14 1.174,624.13 1.00
6 Vanguard Russell 1000 Growth ETF 12.50 69.103.14 664.39 104.0°
7 Olstein All Cap Value Advy 1237 68.382.86 3.370.27 20.2¢
8 Hodges Blue Chip Equity Income Retail 12.26 67.784.10 431471 157
8 T. Rowe Price Emerging Markets Bond Adv nn 61,445.90 5,306.21 115
10 Vanguard Total International Stock ETF 10.00 55.282.51 1.216.60 dz4:
11 i8hares Russell 2000 Growth ETF 10.00 55,282 51 385.78 143.3(
12 American Century Prime Money Mkt Iny 10,00 55,282 51 55,282 51 1.00
13 Franklin Total Return Adv 9.68 h3.530.28 5.462.27 9.80
14 T. Rowe Price Summit Municipal Intm Ady 039 51,837.70 433399 1.8
15 Saba Closed-End Funds ETF 7.50 4145188 4145188 1.00
16 iShares National Muni Bond ETF 7.50 41,461.88 376.89 oo
17 Brown Advisory Emgerg Mkts Select Inv T 30.779.09 3.694.97 8.3
18 Cullen International High Dividend Retl 493 2725859 2.860.29 95
18 iShares Core S&P 500 ETF - = - 208.1:
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Editing a Client Account Exercise 27: Import a model portfolio’s holdings into a client account

6. Double-click the Name column header to sort the column alphabetically.

EDITING HOLDINGS FOR "JOE FRANKLIN"

Joe Franklin 08/05/2019 £%
F
Markat
Name | Weight > Value[USD] > Shares > Price :
|‘ - Double-click here.
Edited 100.00 552,825.10 & i
Existing 100.00 552.825.10 =5 =
Marningstar Mod Tgt Risk TR USD - - - -
Unallocated Cash -100.00 —-552,825.10 —552,825.10 1.00
1 American Century Prime Money Mkt Inv 10.00 55,282.51 55,282 51 1.00
2 Baron Partners Retail 1845 107.537.97 297307 36.1°
3 Brown Advisory Emgerg Mkis Select Inv LT 30,779.09 368497 8.3
4 Brown Advisary Equity Income Adv 15.23 84,168.62 6,680.05 12.8(
& Cullen International High Dividend Retl 493 27,252 59 2.860.29
6 Franklin Total Return Ady 9.68 53.530.28 5.462.27
7 Hodges Biue Chip Equity Income Retail 12.26 67.784.10 431471
2 Invesco BulletShares 2021 HY Corp Bd ETF 15.00 8202376 355438
9 iShares Core S&P 500 ETF — — —
10 iShares National Muni Bond ETF 7.50 41,461.88 376,89
1 iShares Russell 2000 Growth ETF 10.00 55,282.51 385.78
2 iSnares Russell 2000 Value ETF 15.00 8282376 8827
13 Dlstein All Cap Value Adv 1237 68,382.86 337027
14 Saba Closed-End Funds ETF 750 41,451.88 4145188
15 T. Rowe Price Emerging Markets Bond Adv 1111 61.445.90 5.306.21
16 T. Rowe Price Summit Municipal Intm Adv 9.39 51.937.70 4,338.99
17 Vanguard Russell 1000 Growth ETF 1250 62,103.14 664.32
2 uard S&P 500 Value ETF 1250 £9,103.14 1.174,624.13
18 Vanguard Total International Stock ETF 10.00 55,282.51 1,216.60
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Editing a Client Account Exercise 27: Import a model portfolio’s holdings into a client account

7. Re-weight the holdings as shown in the following table:

Investment Weight

American Century Prime Money Mkt Inv 10

Baron Partners Retail 10

Brown Advisary Emgerg Mkts Select Inv 10

Brown Advisory Equity Income Adv 5

Cullen International High Dividend Retl

5
Franklin Total Return Adv 5
Hodges Blue Chip Equity Income Retail 5

Invesco BulletShares 2021 HY Corp Bd ETF | 5

iShares Core S&P 500 ETF 5
iShares National Muni Bond ETF 5
iShares Russell 2000 Growth ETF 4
iShares Russell 2000 Value ETF 4
Olstein All Cap Value Adv 4
Saba Close-End Funds ETF 4
T. Rowe Price Emerging Markets Bond Adv | 4
T. Rowe Price Summit Municipal Intm Adv | 4
Vanguard Russell 1000 Growth ETF 4
Vanguard S&P 500 Value ETF 3
Vanguard Total International Stock ETF 5
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Editing a Client Account Exercise 27: Import a model portfolio’s holdings into a client account

EDITING HOLDINGS FOR "JOE FRANKLIN" Save As Rename Close

Joe Franklin 12/08/2015 % . Allocation: Asset Allocation 06/30/2019
o 18553
!\lame Weight > || o0
Edited |1l3l],ﬂ[ll
Existin o0 Make sure the Edited
ikt , S — Weight is 100.
Marningstar Mod Tqt Risk TR USD = -
Unallocated Cash | i].Dﬂl
1 American Century Prime Money Mkt Iny 10.00
= Aﬂ B n' g ' 0.00 It Unallocated Cash
2 Baron Partners Retall 10000 shows a value other
3 Brown Advisory Emgerg Mkts Select Inv 10.00 than 0, that is the
4 Brown Advisory Equity Income Adv 500 ) ampuhr][t the holding
il g ZE183 weights are over or
5 Cullen International High Dividend Retl 5.00 under 100.
B Franklin Total Return Adv 5.00
7 Hodges Blue Chip Equity Income Retail 5.00 —123.76
8 Invesco BulletShares 2021 HY Corp Bd ETF 5.00 Benchmark £
9 iShares Core 5&F 500 ETF 5.00
10 iShares Mational Muni Bond ETF 5.00 Investment Growth: 10K Growth 08/01/2018 - 07
1 iShares Russell 2000 Growth ETF 5.00 z
7 iShares Russell 2000 Value ETF 400 S
3 Dlstein All Cap Value Adv 400
14 Saba Closed-End Funds ETF 4.00
15 T Rowe Price Emerging Markets Bond Ady 400 nmee
16 T. Rowe Price Summit Municipal Intm Adv 400
17 Vanguard Russell 1000 Growth ETF a0 e
18 Manguard 5&P 500 Value ETF 300 o
18 Vanguard Total International Stock ETF 3.00 IF\
8. Click Recalculate.
9. Click Save, then click Close.
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Editing a Client Account How can | compare a client account to other portfolio objects?

In Working with Custom Benchmarks on page 17, you did the following: How can | compare
a client account to

» created two custom benchmarks other portfolio objects?

» applied them to a client account, and
» compared them to the client account in various components.

In Using an Investment Policy on page 42, you did the following:

» created an investment policy,
» applied it to a client account, and
» compared it to the client account.

In this section, you will compare a client account to other portfolio objects. Such
comparisons can help you do the following:

» evaluate an account’s performance when measured against a model portfolio
» consider the volatility of a client account with objective measures, and
» determine investment gaps to fill.

Comparisons can also be a preliminary step in creating a proposal. When making a
comparison, you might find that an existing portfolio object could be the basis of an
attractive proposal for a client account.

In Exercise 26 on page 78, you created the ABC Model portfolio, and in Exercise 27 on Exercise 28: Associate a
page 82, you imported its holdings to the Joe Franklin account. model portfolio with a

Suppose you want to record which model portfolio was the source of many of the client account

holdings. Associating the model portfolio with the client account is the solution.

Associating a model portfolio with a client account has another use. It allows one more
comparison option (in addition to benchmarks and an investment policy).

In this exercise, you will associate the ABC Model portfolio with the
Joe Franklin account.
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Editing a Client Account Exercise 28: Associate a model portfolio with a client account

Do the following:
1. In the Grid, hover the cursor over the Joe Franklin account.

2. Click the Actions icon and from the menu, select Settings. The Account Settings
window opens.

Portfolio Analysis | Client Accounts

Total Total

Return Return
_ (YTD - (G -
| Name mo-end)  mo-end)
(1 1 Adam Fairchild 15.36 15.36
(1 2 Beverly Dennison - -
[ 1 3 Charles Mack - -
(1 4 Christine Ha 14.63 i3
(1 5 David Franklin 13.88 383
[l F Denniz 2ranct . - Note the highlighted selections.
(1 7 Joe Frankiin () 27.05 2705
0o - :
Ll Account
[l
|
|
|
|

3. Onthe General tab, from the Model Portfolio menu, select ABC Model.

Account Settings Cance @
Calculation _5:::3.]'1!23'554:2'459254E5 | |
None F Note the
highlighted
selections.
4. Click Save.
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What charts and tables can display a client account and an associated

Editing a Client Account model portfolio?
Suppose you want to compare the Karen Franklin account to a model portfolio to What charts and tables
assess the model's usefulness as a benchmark or the basis for a proposal. can display a

client account

In Karen Franklin’s Account Settings window, both benchmark options and the policy
option are in use. In this set of exercises, you will associate the ABC Model with the
Karen Franklin account and compare the model and the account.

Account Settings Cance

e
benera

and an associated
model portfolio?

Calculation » | Sample Custom Benchmark Morningstar Indexes Benchmark <. Sample Investment Policy v

Although you can change these
selections, you have another
option for comparing a client
account and a model portfolio.

The following charts and tables can display both the account and an associated
model portfolio:

» Allocation » Investment Growth
» Equity Style Box » Scatter Plot
» Historical Return » Scenario Metrics

» Historical Risk Exposure ~ » Scenario Trend

» Holdings Plot » Sustainability Ratings Analysis
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Exercise 29: Compare the Global Broad Category allocations of

Editing a Client Account

a client account and its associated model portfolio

In this exercise, you will compare the Global Broad Category allocations of the Karen
Franklin account to the ABC Madel portfolio.
Do the following:

1. Associate the ABC Model with the Karen Franklin account.

< Note: See Exercise 28 on page 87 if you need help with this step.

In the Grid, click the Karen Franklin account. The Analytical View opens.
Select the Allocation tab.
In the Allocation chart, note that the following are displayed:

» a donut chart representing the Karen Franklin account
» adonut chart representing the default benchmark of the Karen Franklin account, and
» the Global Broad Category allocations of the account and the benchmark.

Portfolio Analysis | *Client Accounts

Exercise 29: Compare
the Global Broad
Category allocations of
a client account

and its associated
model portfolio

& Karen Franklin

[] @ Margo Franklin

@l - Analytical View X
Ho t'1gs| Allpcation vl Performance  Return/Risk  Atrribution  Risk Factors  Sce e \ew Tab H
| Allocation = Giobal Broad Category Group = 06/30/2019 = Karen Franklin [a N
= Name The chart
Portfolio Benchmark header
1 Adam Fairchild Ahzmative 0 4 ve . o
4 ! 2y ; S identifies the

Group, today's
date, and the
client account.

5. From the Component Settings menu, select Display Items, then select ABC Model.

Analytical View

Holdings Allocation v Perform

ance
Allocation = Global Broad Category Group = 06/30/2018 = Karen Franklin

Component Settings

Partfolio Date

06/30/2019

Grouping
Global Eroad Catego

2enchmark

Note the
highlighted
selections.

| Display ltems m

i Crankli
karen rrankin

U lemmn

Display Ite
1 Selected

Data View

al EwY

Donut Chart

Clear All
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Exercise 29: Compare the Global Broad Category allocations of

Editing a Client Account

a client account and its associated model portfolio

6. Click away from the Component Settings menu to close it.

The Allocation chart can display only two donut charts at the same time. When you
added the ABC Model as a display item, the donut chart automatically changed to a
stacked bar chart.

Analytical View X
Holdings Allocation v Performance Return/Risk  Attribution  Risk Factors  Sce 9 4+ New Tab 1=
Allocation = Global Broad Category Group = 06/30/2018 | Multiple Investments O 0 O
The chart header
identifies “Multiple
1000 l Alternative Investments” instead
W Eouity of the client account.
Fixed Incoma
75.00 W Maonay Market
50.00
o Each bar is
identified here.
0.00

Karen Frankiin ABC Model Sample Investment Policy|

7. To display only the Karen Franklin account and the ABC Model, from the Component
Settings menu, select Benchmark, then select No Benchmark.

Analytical View

Holdings  Allocation v Performance  Return/Risk  Attribution  Risk Factors  Scei@ -+ Ne

Ly
=1t

Allocation » Global Broad Category Group » 06/30/2019 = Multiple Investmenis

=
L

H

m@

X

Note the
highlighted
selections.

MAORNINGSTAR
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100.00 Component Settings —
x () Benchmark
Partiolio Date ; 3
- 06/30/2019 i Income 21 Seatt ot REnET
7500 Gro Jp:!’la 12y Marky
Global Eroad Catégory Group User Created »
genchmark . 3 Portfolio Benchmark 1
50,00 Sample Investment Policy i
' Partfolio Benchmark 2
Display Settings Portfolio Attached Policy v/
T Display ltems No Benchmark
Gt 2 Selected > —
Data View
i _ Stacked Bar Chart ’
Karen Frankiin ABC Mot
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Editing a Client Account

Exercise 30: Compare the Morningstar Sector allocations
of a client account and its associated model portfolio

8. Click away from the Component Settings menu to close it.

Analytical View

Holdings

100.00

75.00

50.00

25.00

0.00

Allocation v

X
Performance  Return/Risk  Attribution  Risk Factors  Sce@ + New Tab H
Allocation = Global Broad Category Group = D6/30/2018 = Multiple Investiments BN
W Alternative
W Eguity
Fixed Income

B Manay Markst

Karen Frankiin ABC Model

In this exercise, you will display the asset allocations of the Karen Franklin account and
the ABC Model portfolio.

Do the following:

1. Inthe Allocation chart, click the Component Settings menu.

2. From the Component Settings menu, select Grouping, then select Morningstar Sector.

Exercise 30: Compare
the Morningstar
Sector allocations

of a client account
and its associated
model portfolio

Analytical View = Note the
: : T : highlighted
Hoidings Allocation v Performance  Return/Risk  Atinbution  Risk Factors  Sce a 4+ Mew Tab =] selections.
Allocation # Global Broad Category Group ® 06/30/2019 = Multiple Investments B
_ < i
100.00 Component Settings — 5 Camying
Partflio Date 5 P Q. Search All B
o 06/30/2019 d Incoma
i Grouping y (Wi Asset Allocation
Global Eroad Category Group i
Economic Moat
Benchmark 3
50.00 No Benchmark Equity Region
Display Settings GICS Sector
Digplay ltems Markat Ca
2 2 Selected > — i
o '{‘»’Drnmqsta' Sector |
Data View 5 =
0.oa Stacked Bar Chart
Karen Frankiin

MAORNINGSTAR
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Editing a Client Account

Exercise 30: Compare the Morningstar Sector allocations
of a client account and its associated model portfolio

3. Click away from the Component Settings menu to close it.

Holdings

§1.75

3550

0.00

Analytical View

Performance

Karen Franklin

Allocation = Momingstar Sector » 06/30/2019 = Multiple Investiments

X

Return/Risk Attribution  Risk Factors  Sce@y 4+ New Tab M

Bews

M Bazic Matls M=t}

W Comm Sves (Met)
Cans Cyc {Net)
B Cons Def (Net}

ABC Model

M Basic Matis (Met)
W Comm Svcs (Met)
W Cons Cyc (Net)
MW Cons Def (Net)
W Energy (Net)

M Fin Svcs (Met)
W Healthcare (Net)
W [ndustrials (Net)
M Feal Estate (Net)
W Technology {Net)
W Utilities (Net)

2.60
1.29
1.05
3.69
2.63
10.51
.37
1.65
3.46
11.49
2.04

AEC Model

M Energy (Net)
B Fin Sves {Net)
B Healthcare {Net)
B Industrials (Net)
M Real Estate [Net|
B Technaology (Net)
W Utilities |Met)

Hover the cursor
over either bar to
display the numeric
data of the
Morningstar
Sectors.

MAORNINGSTAR
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Editing a Client Account Exercise 31: Delete a client account

At some point in time, Joe Franklin might decide to close his account. In this exercise, Exercise 31: Delete a
you will delete that account. client account

Do the following:

1. In the Client Accounts workbook Grid, hover the cursor over Joe Franklin. The Actions
icon appears.

2. Click the Actions icon and select Delete. An alert dialog box opens, where you can
cancel or continue with the deletion.

Partfolio Analysis | *Client Accounts

3 ) Lolumn et ¥
Total Total Total
Return Return Return
(YTD - [6M - (1Y - mo-
/] Name mo-end] mo-end) end)
@ 1 Joe Frankiin | @l 16.15 16.19 7.04
Account
Note the
Edit Holdinas highlighted selections.
Settings
Jelete
Actions
Generate Portfolio Proposal Report
Generate Portfolios Comparison Report
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Editing a Client Account Exercise 31: Delete a client account

3. Click Delete. The dialog box closes.

Delete Portfolio

Select this option.

Do you want to delete "Joe Franklin"?

Total Return Total Return

| Name (YTD - mo-end)  (6M - mo-end)

= : - ~ | Joe Franklin is no longer listed in
[1]z = — | Client Accounts.

L1]3 463 463

(14 308 3.8

[1]5 - _

[1]s 108 308

L7 848 248

Ll]8 615 .15

(1] o e

[l z =

Ll 274

1|z 18.41

1|z 17.98

(1 |14 s - -
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